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C h a p t er  1  

 

By definition, informatics is the science of computer informational systems. It is a broad academic 

field, encompassing computer science, the study of human-computer interaction, information science, 

information technology and algorithms. Informatics studies the structure, algorithms, behavior, and 

interactions of natural and artificial systems which store, process, access, and communicate 

information. Based on the above, informatics should never be confused with computer programming, 

which is a process that leads from an original formulation of a computing problem to executable 

computer programs. 

Etymology 

In 1957 the German computer scientist Karl Steinbuch coined the word “Informatik” by publishing a 

paper called “Informatik: Automatische Informationsverarbeitung” (“Informatics: Automatic 

Information Processing”). The English term Informatics is sometimes understood as meaning the same 

as computer science. The German word “Informatik” is usually translated to English as computer 

science. 

The French term “informatique” was coined in 1962 by Philippe Dreyfus together with various 

translations – “informatics” (English), also proposed independently and simultaneously by Walter F. 

Bauer and associates who co-founded Informatics Inc., and “informatica” (Italian, Spanish, Romanian, 

Portuguese, Dutch), referring to the application of computers to store and process information. 

The term was coined as a combination of “information” and “automatic” to describe the science of 

automating information interactions. The morphology – informat-ion + -ics – uses “the accepted form 

In this chapter 

o Definition of informatics 

o Etymology 

o Introductory terminology 
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for names of sciences, as conics, linguistics, optics, or matters of practice, as economics, politics, 

tactics”, and so, linguistically, the meaning extends easily to encompass both the science of information 

and the practice of information processing. 

A practitioner of informatics may be called an “informatician” or an “informaticist”. 

Definitions 

Data – values of qualitative or quantitative variables, belonging to a set of items. Data can be measured, 

collected, reported and then later analyzed. For example, measuring the height of individuals in sample 

group of people is collecting the process of collecting the quantitative variable height. Sending the set 

of measurements to a statistician is the process of reporting the data. The statistician calculating 

averages, standard deviations and such is the process of analyzing the data. The process of 

representing data can be achieved by creating graphs and charts based on the measurements. 

Quantitative data can be usually expressed in absolute values and can be accompanied by a unit of 

measurement. For instance, height measured in centimeters, the resistance of a resistor measured in 

kiloohms and the speed of travel measured in kilometers-per-hour are all quantitative data. 

Qualitative data cannot be expressed in absolute values and is often the result of more subjective 

evaluation or measurement process. For example, saying that a flower is beautiful is a subjective, 

qualitative observation related to the value of “beauty” of a flower. Since “beauty is in the eyes of the 

beholder”, the evaluation is both subjective and also cannot be expressed in an absolute value.  

Information – a sequence of symbols that can be interpreted as a message. It can be recorded as signs 

or transmitted as signals. Information is sequences of data and at its most fundamental, is any 

propagation of cause and effect within a system. The role of information is to resolve uncertainty, to 

answer a question. 

Information system – an ensemble of elements involved in the process of collecting, transmitting and 

processing information. This can be a network of people, computers, other electronic devices or all 

these in a mixed system. 

The four main components of any informational systems are: 

✓ Transmitter – [compulsory] the element that is transmitting the information 

✓ Receiver – [compulsory] the element that is receiving the information 

✓ Channel – [compulsory] the medium through which the information is being transmitted 

✓ Information – [optional] sequences of data being transmitted, also called message 

Any information system needs to have at least three components. If the element that sends the 

message is missing, then the system is not transmitting information, therefore is not an informational 

system. If the system is transmitting information, but there is no one listening then the information is 
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lost, and therefore still no transfer of knowledge is taking place. Moreover, the transfer of information 

needs to be done over a transfer medium. 

In any information system it is important that both the transmitter and receiver are able to 

“understand” or decode the message. If the message sent by the transmitter is not understood by the 

receiver, then no actual information exchange is taking place. The receiver should be able to interpret, 

react to or store the message being transmitted. For example, two foreigners who do not speak the 

same language, although can talk to each other, no information exchange will take place. No 

information exchange might also happen if the two communication sides do understand each other, 

however no information is being transmitted at a given point. This is called silence of transmission. 

 

Figure 1.1. Computer network 

 

Figure 1.2. Human-computer interaction 

In informatics the two major information systems are computer networks (Figure 1.1) and the human-

computer interaction (Figure 1.2). 

In a computer network, the server can be both the transmitter, when it is serving information to a 

request and the receiver, when it is receiving request from any computer on the network. The same 

principle applies to any device connected to the network. When both communicating parties can be 

both transmitters and receivers simultaneously, the communication is called full duplex. Half duplex 

communication is defined as both communication parties being able to be both transmitters and 

receivers but can only take one role at a time. In a simplex communication protocol, there are well 

defined transmitters and receivers, and they cannot change roles. 

In the case of the computer network, the transmission medium can be a coaxial or UTP cable, a fiber 

optics cable or radio waves, in case of wireless transmissions. In the case of the human-computer 

interaction, the transmission media are the wires running from any input device (keyboard, mouse, 

touchscreen, etc.) to the component on the motherboard that processes the given signals. 

Computer – an informational system that can be programmed to carry out a set of arithmetic or logical 

operations. In other words, it is an electronic device that manipulates information or data with the 

ability to store, retrieve, and process data. Since a sequence of operations can be readily changed, the 

computer can solve more than one kind of problem (i.e.: you can both solve complex equations using 

dedicated programs, model electronic circuits, as well as play games).
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C h a p t er  2  

 

Computer hardware is defined as a collection of physical elements that constitutes a computer 

system. Basically, everything that is around a computer, which is tangible, is referred as hardware. 

These can vary in shape and size and usually vary by functionality. They include, but are not limited to 

the input devices of the computer (keyboard, mouse, touch screen, etc.), the output devices (monitors, 

speakers, printers, and such) and the main case of the computer to which all these devices, called 

peripherals connect, and which does the actual computing. Inside the case more components can be 

found, which will be detailed later. 

Generally, personal computers vary in shapes and sizes, however, based on their portability, two 

main categories are distinguished. Stationary computers, often called desktop computers, have 

multiple computers which are installed on a desk top (hence the name), while laptop computers are 

the portable version of these. The main differences between these two are their size, performances 

and the way they are powered. While desktop computers are bulkier, they are easier to upgrade by 

switching older components with new generation ones, and due to better cooling policies, have usually 

higher performances than laptop computers. Stationary computers are powered directly from mains 

electricity and therefore cannot run without a direct connection to a power source. On the other hand, 

laptop computers are equipped with battery packs which can be recharged and can power the 

computer for a limited time without the need of connection to mains power. The time it takes the 

battery of the laptop to go from a full charge to a full discharge is called autonomy and is measured in 

In this chapter 

o Personal computers 

o Desktop PCs, laptop PCs, embedded devices 

o Architecture of a PC 

o How to build your own PC from scratch: 

• Description of hardware components 

• Component selection and compatibility 
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hours. Autonomy can vary greatly with the type of battery used, its size, as well as the workload of the 

laptop. 

Personal computers come in two main styles: PC and Mac. Both are fully functional, but they have a 

different look and feel, and many people prefer one or the other. 

PCs began with the original IBM PC that was introduced in 1981. Other companies began creating 

similar computers, which were called IBM PC Compatible (often shortened to PC). Today, this is the 

most common type of personal computer, and it typically includes the Microsoft Windows operating 

system. 

  

Figure 2.1. A Serioux 
Advantage V2 

desktop PC 

 

Figure 2.2. A Toshiba 

Satellite laptop PC 

 

Figure 2.3. An 
Apple Mac Pro 

desktop computer 

 

Figure 2.4. An Apple 
Macbook Air laptop 

computer 

The Macintosh computer (Mac – for short) was introduced in 1984, and it was the first widely sold 

personal computer with a graphical user interface, or GUI. All Macs are made by one company, Apple 

Inc., and they almost always use the Mac OS X operating system. Both PCs and Macs come in desktop 

and laptop form, as presented in the figures above. 

More portable, but lower performance variant of the laptop computers are tablets and smartphones. 

Tablet computers (or tablet) are handheld computers that instead of a keyboard or touchpad use a 

touch-sensitive screen for typing and navigation.  

Tablets can't necessarily do anything a laptop or a desktop can do, so you may still want a desktop or 

laptop to run programs or create documents. But if you just want to be able to play low to medium-

end games, check email and social media, or stream music and videos, a tablet may be a good computer 

replacement. Smartphones, tablets, and other smart devices are generally referred to as embedded 

devices in electronics. 

On the other hand, servers are a more powerful, not-at-all portable variants of desktop computer. 

Servers are computers that serve up information to other computers on a network. Many businesses 

have file servers where employees can use to store and share files. A server can look like a regular 

desktop computer, or it can be much larger, however servers which function in average to large 

networks are regularly very powerful computer configurations or clusters of such computer 

configurations. 
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Servers also play an important role in making the Internet work: They are where webpages are stored. 

When you use your browser to click a link, a web server delivers the page you requested. 

General architecture 

The template for all modern computers is the Von Neumann architecture (Figure 2.5), detailed in a 

1945 paper by Hungarian mathematician John von Neumann. This describes a design architecture for 

an electronic digital computer with subdivisions of a processing unit consisting of an arithmetic logic 

unit (ALU) and processor registers, a control unit containing an instruction register and program 

counter, a memory to store both data and instructions, external mass storage, and input and output 

devices The meaning of the term has evolved to mean a stored-program computer in which an 

instruction fetch and a data operation cannot occur at the same time because they share a common 

bus. This is referred to as the Von Neumann bottleneck and often limits the performance of the system. 

 

Figure 2.5. Simplified von Neumann architecture scheme 

An exploded view of a general desktop computer is presented in Figure 2.6. Here the parts can be 

identified as presented in the following table. 

Part number Part name 

1 Monitor 

2 Motherboard 

3 Central processing unit (CPU) 

4 Random access memory (RAM) 

5 Expansion cards (video card, USB hubs, etc.) 

6 Power source 
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7 Optical unit (CD/DVD/Blu-ray) 

8 Hard disk (HDD) 

9 Keyboard 

10 Mouse 

 

Figure 2.6. Exploded view of a general desktop computer 

In the following pages, each component will be explored in detail, to aid in better understanding the 

functionality of each and how components interact with each other to build one integrated 

computation system. 

Computer case 

The computer case is the metal and plastic box that contains the main components of the computer. It 

houses the motherboard, central processing unit (CPU), power supply, and more. 
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Computer cases come in different shapes and sizes. A desktop case lies flat on a desk, and the monitor 

usually sits on top of it. A tower case is tall and sits next to the monitor or on the floor. The front of the 

case usually has an on/off switch and one or more optical drives. 

                   

Figure 2.7. Tower case vs. desktop case vs. caseless PC 

Most of the personal computers you can purchase today include tower cases rather than desktop 

cases; however, some computers are being made with all of the internal components built into the 

monitor (caseless PCs), which eliminates the need for a tower, the most popular and widely used these 

being Macs manufactured by Apple. 

Motherboard 

A motherboard (sometimes alternatively known as the mainboard, system board, planar board, or 

logic board, or colloquially, a mobo) is the main printed circuit board (PCB) found in computers and 

other expandable systems. It holds and ensures communication between the crucial electronic 

components of a system, such as the central processing unit (CPU) and memory and provides 

connectors for other peripherals. 

A motherboard provides the electrical connections by which the other components of the system 

communicate. A typical desktop computer has its microprocessor, main memory, and other essential 

components connected to the motherboard. Other components such as external storage, controllers 

for video display and sound, and peripheral devices may be attached to the motherboard as plug-in 

cards or via cables, in modern computers it is increasingly common to integrate some of these 

peripherals into the motherboard itself. 
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Figure 2.8. Block diagram of a motherboard 

An important component of a motherboard is the microprocessor's supporting chipset, which 

provides the supporting interfaces between the CPU and the various buses and external components. 

This chipset determines, to an extent, the features and capabilities of the motherboard. 

The block diagram of a modern motherboard can be seen in Figure 2.8. As can be seen, every 

motherboard is divided into two main functional blocks: the Northbridge and the Southbridge. 

The Northbridge, also called the memory controller hub or host bridge, is usually a controller chip 

that is directly connected to the CPU and RAM memory, as well as most expansion slots. Therefore, the 

Northbridge is responsible for the tasks that require the highest performance. Some Northbridges also 

contain integrated video controllers, also known as a Graphics and Memory Controller Hub (GMCH) in 
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Intel systems. Because different processors and RAM require different signaling, a given Northbridge 

will typically work with only one or two classes of CPUs and generally only one type of RAM. 

The Southbridge typically implements the slower capabilities of the motherboard. It handles all of a 

computer's I/O functions, such as USB, audio, serial, the system BIOS, the ISA bus, the interrupt 

controller and the IDE channels. 

Due to the push for system-on-a-chip (SoC) processors, modern devices increasingly have the 

Northbridge integrated into the CPU die itself (ex.: Intel's Sandy Bridge and AMD's Fusion processors, 

both released in 2011). The Southbridge became redundant and it was replaced by the Platform 

Controller Hub (PCH) architecture introduced with the Intel 5 Series chipset in 2008. All Southbridge 

features and remaining I/O functions are managed by the PCH which is directly connected to the CPU 

via the Direct Media Interface (DMI) 

The two main controller chips of the Northbridge and Southbridge (excluding all other connectors and 

slots) are also referred to as the Chipset of the Motherboard. 

It is beyond the scope of this book to analyze every technical aspect and characteristic of a 

motherboard. However, next the most important characteristics that the reader needs to know about 

when shopping for a motherboard for a custom-built PC will be presented. To illustrate this, the full 

technical specifications, as offered by most online retailers, of a Gigabyte motherboard are presented 

in Table 2.1. 

 

Figure 2.9. Gigabye GA-Z97-SOC motherboard 
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Table 2.1. Gigabyte GZ-Z97-SOC Motherboard technical specifications (www.newegg.com) 

Model 

Brand GIGABYTE 

Model GA-Z97X-SOC Force 

Supported CPU 

CPU Socket Type LGA 1150 

CPU Type Core i7 / i5 / i3 / Pentium / Celeron (LGA1150) 

Chipsets 

Chipset Intel Z97 

Memory 

Number of 

Memory Slots 

4×240pin 

 

Memory Standard DDR3 

3300(OC)/3200(OC)/3100(OC)/3000(OC)/2933(OC)/2800(OC)/2666(OC

)/2600(OC)/2500(OC)/2400(OC)/2200(OC)/2133(OC)/2000(OC)/1866(

OC)/1800(OC)/1600/1333 

Maximum Memory 

Supported 

32GB 

Channel Supported Dual Channel 

 

Expansion Slots 

PCI Express 3.0 

x16 

1 (x16) 

1 (x8) 

1 (x4) 

PCI Express x16 1 (x4) 

PCI Express x1 1 x PCI Express x1 

PCI Slots 2 x PCI Slots 

Storage Devices 

SATA 6Gb/s 6 x SATA 6Gb/s 

SATA Express 1 x SATA Express 

javascript:void(0);
javascript:void(0);
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SATA RAID 0/1/5/10 

 

Onboard Video 

Onboard Video 

Chipset 

Supported only by CPU with integrated graphic 

Onboard Audio 

Audio Chipset Realtek ALC1150 

Audio Channels 7.1 Channels 

Onboard LAN 

LAN Chipset Qualcomm Atheros Killer E2201 

Max LAN Speed 10/100/1000Mbps 

Rear Panel Ports 

PS/2 1 x PS/2 keyboard/mouse port 

Video Ports 

 

1 x DVI-D 

1 x VGA 

1 x DisplayPort 

HDMI 1 x HDMI 

RJ45 1 x RJ45 

USB 3.0 4 x USB 3.0 

USB 1.1/2.0 4 x USB 2.0 

S/PDIF Out 1 x Optical 

Internal I/O Connectors 

Onboard USB 2 x USB 3.0 + 4 x USB 2.0 

Other Connectors 

 

1 x 24-pin ATX main power connector 

1 x 8-pin ATX 12V power connector 

1 x 4-pin ATX 12V power connector 

1 x OC PEG power connector 

1 x CPU fan header 

1 x water cooling fan header (CPU_OPT) 

6 x system fan headers 

1 x front panel header 

1 x front panel audio header 

1 x S/PDIF Out header 

javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
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1 x serial port header 

1 x Clear CMOS jumper 

1 x power button 

1 x reset button 

1 x Clear CMOS button 

1 x Gear button 

1 x OC Turbo button 

1 x OC Tag button 

1 x OC Trigger switch 

1 x CPU BCLK Down button 

1 x CPU BCLK Up button 

1 x CPU Ratio Down button 

1 x CPU Ratio Up button 

1 x Memory Safe button 

1 x Settings Lock button 

1 x Direct to BIOS button 

1 x OC DIMM switch 

1 x OC PCIe switch 

1 x OC Ignition button 

1 x Clear Battery button 

2 x BIOS switches 

1 x onboard voltage measurement module 

Physical Spec 

Form Factor ATX 

Dimensions (W x 

L) 

12.0" x 9.6" 

Power Pin 24 Pin 

Features 

Features 

 

Supports 4th and 5th Generation Intel Core processors 

Premium 4-way CrossFire support with OC Brace 

Precise digital CPU power design 

SATA Express support for 10 Gb/s data transfer 

Exclusive GIGABYTE OC Features 

Killer E2200 gaming networking 

2x copper PCB design 

Realtek ALC1150 115dB SNR HD Audio with Built-in rear audio amplifier 

New Heatsink design with 8 onboard fan connectors 

Long lifespan Durable Black Solid caps 

APP Center including EasyTune and Cloud Station utilities 

GIGABYTE UEFI DualBIOS 
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At first glance, such a large table, with so many technicalities might seem frightening and as a result 

put off most users from the adventures of custom computer building. But fear not, most are not that 

difficult to grasp, you do not even need to understand each and every one, and a couple are just 

irrelevant things that the manufacturer likes to “brag” with. 

First, there are the manufacturer name and the name of the motherboard itself, which may seem 

irrelevant, however, once you narrowed down your decision to a few choices, it is always a good idea 

to hit up the site of a few well known electronics retailers and read customer reviews, or at least see 

the customer satisfaction score. You may be surprised to find that one of your choices suffers from 

overheating problems, for example, while another one has audio problems. Of course, this is rarely the 

case, but being well informed before buying can still save you time and money. 

The CPU socket actually represented the type of connector mounted on the motherboard, in which 

you can plug in your CPU. This is a vital piece of information since the CPU you choose must have the 

same socket (a.k.a. must be compatible with the motherboard). Most manufacturers also list the 

compatible CPUs and bear in mind that your choice is limited to these and only these CPUs. If you prefer 

a CPU type that is not listed here, you must choose another motherboard. 

The next relevant pieces of information are related to memory. Specifically, the number of memory 

slots, the type of memory supported and supported memory speeds (in MHz). The number of slots is 

relevant so as to inform you on how to distribute your memory. For instance, if you have 4 memory 

slots and want to install 16 GB of RAM, you can buy 4 pieces of 4 GB RAM memory cards. However, if 

you have only 2 slots, you will need to buy 2 pieces of 8 GB RAM memory cards. It is good to know that 

higher capacity memory cards are usually a little bit more expensive. 

Also, a relevant piece of information is the maximum memory that you can install. The general rule of 

thumb is that the more, the better. Based on the main activity of the PC your building, you might not 

need to install the maximum accepted memory (maybe ever) but take into consideration that a well 

maintained system might last you up to 5-7 or even 10 years, over which you may want to upgrade. 

Currently, general systems for office use work well with 8 GB of memory. Higher usage systems, like 

those used in engineering with specialized computer aided design (CAD) tools might require from 12 

to 16 GB, while the most memory hungry applications are high end games. 

Expansion slots give you the opportunity to add extra functionality to the motherboard. Most 

common usage for these is to install dedicated video cards, sound cards, USB cards and other 

specialized data acquisition cards for engineering. Take a note of what expansion card slots are 

available because any card that you want to install will have to be compatible with the available slots. 

The speed of these slots is from highest to lowest: PCI Express 3.0 → PCI Express → (simple) PCI 

Next, the storage device (a.k.a. hard disk drive and optical drive) connectors. The industry standard 

connector on all modern motherboards is the SATA connector, which replaced the old parallel ATA 

connector. Being the only connector currently widely used for connecting storage devices to 

motherboards, all you need to know is that the 6 GB/s SATA is faster than the Express version. Make 

sure that if your motherboard has the faster version, so does the hard disk that you buy. The 
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connectors are compatible for all versions, however, the transfer limit will always be imposed by the 

slowest device.  

Most motherboards come with onboard video and audio options. These allow to connect at least one 

monitor and one pair of speakers/headphones, without the need of expansion cards. While for 

connecting multiple monitors or for high-end graphics a dedicated video card is necessary, for a low 

to medium end system, such as those used for productivity and office tasks, the onboard video 

provided will do just fine. 

On the audio part, most motherboards (like the one presented) are able to connect even to advanced 

audio systems and as a result, using a dedicated audio card is only needed for music fanatics or people 

actually working in the music industry. 

When it comes to networking, the main characteristic of the onboard LAN connection (also called a 

NIC – network interface controller) is the maximum transfer speed. With internet speeds getting ever 

higher, it is a good idea to get a card that supports Gigabit speed – that is it has 1000 Mbps (or 1 Gbps) 

in its speed rating. 

Video ports are also of major importance if you want to connect directly to the onboard video card. 

Always make sure that the motherboard and that the monitor you intend to buy have the same type of 

connector. Otherwise, you may end up buying sometimes expensive adapters and sacrificing picture 

quality. 

A two-in-one solution for both video and audio is the HDMI connector, which allows the connection 

of both picture and sound through the same cable. Look for this type of connector if you want to link 

your system to a smart TV through a single cable. 

The RJ45 connector refers to the industry standard connector used to connect to the internet via a 

wired connection. If the motherboard has onboard LAN, it will definitely have an RJ45 connector. 

The last connector type you should look for are the USB connectors. Bear in mind that USB 3.0 is 

faster than older generation 2.0 connectors. However, USB 3.0 is only used for data transfer to USB 

flash (pen) drives, external hard drives, etc. USB 2.0 is just fine for connecting peripheral devices 

(keyboards, mice, printers, etc.). 

Finally, in the other connectors section, you should always check that the power connectors of the 

motherboard are compatible with the connectors offered by the power supply you intend to buy. 

And with that, you know everything there is to when buying a motherboard for a custom-built PC. Now 

that wasn’t so hard, was it? 
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BIOS and UEFI 

Besides its physical role of connecting components amongst each other, the motherboard also has the 

vital role of storing and executing the Basic Input/Output System (BIOS). The BIOS is basically a piece 

of software code (often referred to as firmware) that is stored in a non-volatile memory of the 

computer and is basically the first program to execute when your computer is powered on. 

The most important role of the BIOS is to initialize and test the system hardware components and to 

start the boot loader which then loads the operating system. In addition to this it also offers a layer of 

abstraction for the hardware, a consistent way for application programs and operating systems to 

interact with peripheral hardware in particular. 

Every BIOS version is specifically designed to work with a given computer or motherboard model, 

because it is heavily hardware dependent, given that it needs to interface with the various devices that 

make up the complementary chipset. 

In recent computers, the BIOS is replaced by the UEFI (Unified Extensible Firmware Interface), which 

extends the functionalities of the BIOS. The UEFI is a specification that defines a software interface 

between an operating system and platform firmware. UEFI can support remote diagnostics and repair 

of computers, even without another operating system. 

The boot order, boot priority or boot sequence are always defined using the BIOS/UEFI. Via this setting 

the user can define where and in what order devices are searched for a bootable application, to which 

the BIOS/UEFI can hand over control. Devices that can store bootable applications are called boot 

devices, and these can be a hard disk drive, optical media (CDs, DVDs), flash drivers or network 

interface controllers (which don’t actually store data, but can offer access to it via a network). 

The boot priority is especially important when you want to install or reinstall your operating system 

or are having difficulties booting starting your current operating system. In case your system does not 

boot from the desired location, check and modify as necessary the boot settings of your system.  

Most systems also offer a quick boot menu, which you can access by pressing a designated key (usually 

F12 or TAB) on your keyboard during the startup process. This key is shown on the interface that 

displays on startup. This boot menu can be used to boot from a desired media one time, after which 

the boot order is respected by the BIOS/UEFI on the next startup. 

For a faster startup of your system, you should always set your hard disk drive that contains 

the operating system as your primary boot device. This way, you avoid the time it takes the 

computer to look for bootloaders on the optical media and/or flash drives that might be 

present in your computer. 
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Figure 2.10. Typical BIOS graphical user interface with menu 

   

Figure 2.11. UEFI graphical user interfaces 
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Access to the BIOS/UEFI menu is usually done by pressing a special key (usually F2, Delete, Esc, but 

can be other) during the computer startup process for computers running Windows 7 or later. If you 

are running Windows 8 or later on a system with UEFI, especially with solid state drives, this method 

does not work. In this case you need to perform one of the following to perform a reboot into the UEFI 

menu: 

✓ Under “PC Settings” go to “General” and under “Advanced startup” select “Restart now” 

✓ Hold down the Shift key while clicking “Restart” in the “Power” menu 

✓ Run the following command line from a command shell: “shutdown /r /o” 

Troubleshooting 

As mentioned before, during system startup the BIOS/UEFI does a system test to make sure everything 

is functioning according to their intended purpose, before handing over the control to the operating 

system. If this self-test fails for whatever reason, the computer may not start the operating system and 

instead will report the error to the user. 

The most obvious way of reporting an error is displaying a message stating the encountered problem 

on the screen. However, sometimes a display may not be connected to the computer or there might be 

a problem with the graphics, preventing the BIOS/UEFI to display messages to the user. For this 

reason, the computer also has two other mechanisms for notifying the user of the error that occurred: 

by using a number of diagnostic LEDs on the back pane and via a series of beep codes. 

Diagnostic LEDs are usually found on the back pane of a computer and consist of a series of LEDs, like 

those in Figure 2.12, that light up in different configurations if an error occurred. These might not light 

up at all in case of no error or might light green if the system test passed. They may only light up if the 

system test failed or might change their color if so.  

 

Figure 2.12. Diagnostic LEDs on the back pane of a PC 
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There is no one standard, each manufacturer can define its own, and even with the same manufacturer, 

the codes might differ from one model to the other. However, these codes and their meanings are 

always defined in the Service Manual of the computer, so a quick search on the Internet (we are 

assuming that you have long lost the service manual that came with your computer) should always 

provide you with the necessary explanations. 

In Figure 2.12 an excerpt from a Dell Optiplex 990 desktop computer Service Manual is shown. The 

figure explains the error code represented by the first two diagnostic LEDs off and the next two on 

means that the RAM memory modules are detected in their respective slots but cannot be powered. 

Then, steps to solve the issue are provided. 

Assembling/disassembling a computer is not that hard and should be a fairly 

straightforward task. However, before opening the case always shut down/power off the 

computer, put all power buttons in the off position and disconnect all power cables from the 

plugs and from the case. Moreover, you should wait at least 30 seconds before handling any 

components as some capacitors may take time to discharge. 

 

Figure 2.13. Example of diagnostics LED code 

Another alternative way of communicating errors to the user are beep codes. During the startup 

process if errors are detected the computer will beep a sequence of short or long sounds, which also 

represent an error code. As show in Figure 2.14, the interpretation of these can also be found in the 

Service Manual. 
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Figure 2.14. Examples of beep diagnostic codes 

Central Processing Unit (CPU) 

Remember 10 pages ago, when we set off to build our own computer? We took the long way around, 

didn’t we? Well, it’s time to get back on the main road and head towards our goal again. 

The central processing unit (CPU) is practically the “brain” of the computer. Even though it cannot 

function without a motherboard and other components it connects to, nor can other components 

function without the CPU (seen in Figure 2.15).  

 

Figure 2.15. A CPU: Intel Core i5 750 (top and bottom view) 

By definition the CPU is the electronic circuitry within a computer that carries out the instructions of 

a computer program by performing the basic arithmetic, logical, control and input/output (I/O) 
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operations specified by the instructions. The term has been used in the computer industry at least 

since the early 1960s. Traditionally, the term CPU refers to a processor, more specifically to its 

processing unit and control unit (CU), distinguishing these core elements of a computer from external 

components such as main memory and I/O circuitry. 

Table 2.2. Intel Core i7-4790K Haswell specifications (www.newegg.com) 

Model 

Brand Intel 

Processors Type Desktop 

Series Core i7 

Name Core i7-4790K 

Model BX80646I74790K 

CPU Socket Type 

CPU Socket Type LGA 1150 

Details 

Core Name Devil’s Canyon 

# of Cores Quad-Core 

# of Threads 8 

Operating Frequency 4.0GHz 

Max Turbo Frequency 4.4GHz 

L2 Cache 4 x 256KB 

L3 Cache 8MB 

Manufacturing Tech 22nm 

64-Bit Support Yes 

Hyper-Threading Support Yes 

Virtualization Technology 

Support 

Yes 

Integrated Graphics Intel HD Graphics 4600 

Graphics Base Frequency 350 MHz 

Graphics Max Dynamic 

Frequency 

1.25 GHz 
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PCI Express Revision 3.0 

Max Number of PCI Express 

Lanes 

16 

Cooling Device Heatsink and fan included 

 

Fortunately, Table 2.2, which presents the technical specifications of CPUs as you would find them on 

a retailer’s website isn’t as long as the one for the motherboard. However, here to, there are key 

parameters you should always check before buying a CPU and some information that can be totally 

neglected. 

The name and the brand of the processor are important only if you are a fan of one particular brand. 

Some prefer Intel, others prefer AMD based on their previous experiences, but there is no real winner 

here. Well, actually there is, Intel, who has about 70% percent of the market share, however, this 

should never impact your decision, because it does not impact performance. 

The model name of the CPU may be important if the motherboard specifically states that it is 

compatible with such a CPU. If not, the most important factor when pairing motherboard to CPU is the 

CPU socket type. We already talked about this when discussing the motherboard, remember? Yes, they 

should definitely be the same both on the CPU as well as on the motherboard. 

The core name is of no importance at all, it is just something with which marketing people at the 

manufacturer’s HQ can play around giving them code names such as Vishera, Haswell-E or Devil’s 

Canyon (Uuuh! Fearsome!) 

What you should pay attention is the number of cores. This will mainly determine the power of your 

processor. Dual-core means two cores, quad-core means four, octa-core means eight, etc. This is 

basically a quantification of how many independent tasks can a processor perform in parallel.  

The “# of threads” (number of threads) is the number of tasks the processor can execute (almost, but 

not quite) in parallel. This is sometimes expressed as threads per core. This allows a single physical 

processor core to act like multiple logical cores. Our example processor has four cores and eight 

threads and simple math leads us to two threads per core. General rule of thumb for both cores and 

threads per core: the higher, the better. 

The operating frequency is basically the clock rate at which your processor runs. What is clock rate? 

Take a year of digital electronics, come back, and I’ll explain, at which point you won’t need me because 

you had already found out. Let’s just agree that it the speed at which your processor cores run, and 

like running, the faster, the better.  

If the clock frequency is like running, the maximum turbo frequency is like a short sprint for the CPU. 

Just like any jogger, to keep itself cool (electronics don’t like heat), the CPU prefers to run at its 



Applied Informatics 

27 

designed frequency (or at a lower one), however, should the need arise (an application requires 

instant results for large amounts of data) the CPU can go for a short sprint, when it increases its clock 

frequency to the maximum turbo frequency. This increase can only be maintained for short bursts of 

time (until the heat management algorithm determines that it’s close to overheating), after which the 

CPU would return to its normal operating frequency.  

L2 and L3 cache sizes are the size of memories close (built in) to the CPU. The more you have, the less 

the CPU will need to write to the RAM memory, so operation speed will increase. 

The manufacturing technology is supposed to define the size of the transistors used in the CPU, 

however, this is a marketing lie. A 22 nm processor does not really use 22 nm transistors. However, 

on a general note, the smaller this number, the newer the manufacturing technology of the processor.  

Every processor manufactured currently (for computers, at least) supports a 64-bit architecture, so 

this is nothing to worry about. 

You should glimpse at the maximum number of PCI Express Lanes supported. This is the maximum 

number of expansion cards you can add to your system, but I highly doubt you’ll ever need more than 

the manufacturer provides. 

Heat is the killer of electronics, especially for delicate devices like microprocessors. These can usually 

run at temperatures only up to around 105-125°C, until irreversible damage occurs. These devices 

usually dissipate more than 100W, so their small surface area can get quite hot very rapidly. This is 

why installing a cooler and heat-sink for your microprocessor is very important. These are usually 

aided in extracting heat from the device by a fan. 

Whenever you observe significant decreases in the response times of your computer, or you 

hear the fan constantly running at high speeds, you should always check the state of the heat 

sinking elements on the processor. The general causes of such behavior are dust 

accumulations on the processor or the drying out of the thermal paste between the 

processor and the heatsink. Disassemble the heatsink and fan from the processor. Clean both 

components (do not use water or solvents!) and apply a fresh layer of thermal paste (the 

best ones are with silver or gold particles) between the CPU and heatsink and mount 

everything back to its place. It will not only make your PC much more silent, it will also boost 

its performance and prolong its life. Repeat this about once a year. 

In order to protect the CPU to prolonged exposures to high temperatures, the motherboard is 

equipped with a temperature sensor underneath the CPU which constantly measures the heat 

dissipated by the processing unit. This sensor is constantly monitored by the operating system, which 

is also aware of the maximum accepted temperature of your CPU, depending on the model. This 

temperature is always defined in the datasheet of the CPU and is referred to as the maximum junction 

temperature (Tjmax). Tjmax ranges from 95°C to about 125°C for different types of processors. 
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Figure 2.16. CPU thermal management 

Although these temperatures might seem quite high, if, for whatever reason, your cooling elements 

are not dissipating heat efficiently, the CPU can reach its maximum junction temperature in a matter 

of seconds when subjected to high loads. Should this situation ever occur, the operating system will 

prevent prolonged heat exposure to the CPU by performing a thermal shutdown. In other words, 

when the OS sees your CPU temperatures getting dangerously close to Tjmax, it will halt the system. This 

can be quite scary to the user, because the PC simply stops without any warning, message or without 

a shut down. Even more scary is the fact that the BIOS will then not allow you to turn your computer 

back on until the CPU has cooled down sufficiently.  

So, if your PC ever goes blank during high loads (e.g.: gaming, video processing, etc.) and will not turn 

back on immediately, let it cool down and attempt to restart it afterwards. If the problem persists, you 

need to take action to clean your CPU cooling system, as described earlier on in this chapter. 

In Figure 2.17 you can see an application called Core Temp running on Windows 7 and providing 

temperature data for an Intel Core i5 2500 processor. As it can be seen from the figure, this processor 

has a Tjmax of 98°C and at the time of the screenshot being captured, all four cores had temperatures 

between 39°C and 46°C. As it can be observed, there can be differences of several degrees between 

different cores, depending on their load. A thermal shutdown will occur when any of them is near 

critical temperature.  
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Figure 2.17. Core Temp application showing CPU temperatures 

Random Access Memory (RAM) 

Right, getting back to building our computer. We have the “brains” and now we need somewhere to 

store the information that the CPU is spewing out at a very high speed. As a result, we need a means of 

fast storage in order to collect that information. And this is where the Random-Access Memory (RAM) 

comes in. 

A random-access memory device allows data items to be accessed (read or written) in almost the same 

amount of time irrespective of the physical location of data inside the memory. In contrast, with other 

direct-access data storage media such as hard disks, CD-RWs and DVD-RWs, the time required to read 

and write data items varies significantly depending on their physical locations on the recording 

medium, due to mechanical limitations such as media rotation speeds and arm movement. 

Today, random-access memory takes the form of integrated circuits. RAM is normally associated with 

volatile types of memory (such as DRAM memory modules), where stored information is lost if power 

is removed, although many efforts have been made to develop non-volatile RAM chips. 

In Table 2.3 the main characteristics of a RAM memory kit are presented, as they are usually described 

by most retailers. The two most important characteristics are the type of memory and the size 

installed. 
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Figure 2.18. RAM memory: Kingston FURY Beast DDR4 

The type of memory is important because it must match the type of memory supported by your 

motherboard. The newest, and most common type of RAM memory used is the DDR SDRAM (Double 

Data Rate Synchronous Dynamic Random-Access Memory) of which an earlier version (DDR4) is still 

in use, however the newest technology commercially available1 is DDR5. Usually, different types of 

memories will only fit in the motherboard if they are the same technology as the motherboard accepts, 

so bear this in mind when purchasing RAM memory. 

Table 2.3. Kingston FURY Beast characteristics (newegg.com) 

Model 

Brand Kingston 

Series FURY Beast 

Model KF432C16BBK2/16 

Details 

Capacity 16GB (2 x 8GB) 

Type 288-Pin PC RAM 

Speed DDR4 3200 

CAS Latency 16 ns 

Timing 16-18-18 

Voltage 1.35V 

Multi-channel Kit Dual Channel Kit 

 

 
1 at the time of editing this book (July 2024) 
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After the CPU characteristics, the size of RAM memory installed on a system is the second most 

important feature which greatly impacts the performance and speed of the PC. General rule of thumb 

is that the more RAM memory a system has, the better it will perform, however, exaggerating can be a 

waste of money. 4 to 8 GB should be enough for a typical general-purpose computer (office 

applications, internet browsing, etc.), while a computer used for engineering should have around 12-

16 GB of RAM (when used for simulations, modelling, etc.). High end PCs (used for video/photo editing, 

gaming, etc.) should have 16 to 32 GB of RAM. 

To be noted however, that each motherboard only supports limited amount of RAM memory (i.e.: 32 

GB for the motherboard presented in Table 2.1). Also, as seen in Figure 2.18, RAM memory comes in 

sticks which need to be installed in slots on the motherboard. A typical motherboard may have usually 

2 or 4 RAM slots, so attention must be paid to ensure that enough slots are available to accommodate 

the number of RAM sticks to be installed.  

The number of memory channels on a system is another important feature of RAM that can impact the 

computer’s data transfer speed. RAM modules communicate with the CPU through a memory 

controller, which uses a bus to transfer data between the CPU and memory. Some memory controllers 

support multiple channels, allowing data to travel on several paths simultaneously, which boosts data 

exchange rates. Channel configurations vary, with some memory controllers supporting single, dual, 

or quad-channel setups, while others offer six or eight channels, the latter two primarily designed for 

server environments. To fully utilize multi-channel memory architecture, RAM modules need to be 

installed in groups matching the system’s channel configuration—two modules for dual channel, four 

for quad channel. 

If you are very nerdy about your RAM memory being fast, then you might also want to take a look at 

the CAS latency. Column Access Strobe (CAS) latency is the delay time between the moment a memory 

controller tells the memory module to access a particular memory column on a RAM module, and the 

moment the data from the given array location is available on the module's output pins. It is usually 

measured in nanoseconds, and the lower the latency, the faster the RAM memory. 

Hard Disk Drive (HDD) 

Since RAM memory is a volatile means of storage, a computer also generally needs non-volatile (that 

is permanent) storage. Permanent storage can store data almost indefinitely, even if the device is not 

powered. A hard disk drive (HDD) is a good example of such a storage medium. 

Nowadays, HDDs come in three types: classical (mechanical) hard disks, solid-state drives (SSDs) and 

hybrid hard disks (SSHD). 

Mechanical (or classical) hard disks are data storage devices used for storing and retrieving digital 

information using one or more rigid ("hard") rapidly rotating disks (platters) coated with magnetic 

material. The platters are paired with magnetic heads arranged on a moving actuator arm, which read 
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and write data to the platter surfaces. Data is accessed in a random-access manner, meaning that 

individual blocks of data can be stored or retrieved in any order and not only sequentially. As a result, 

their performance is limited by two factors: the speed at which the mechanical patters spin and the 

speed at which the reading head is able to travel across the plates to read information. Due to their 

mechanical nature, these hard disks are much slower than the new technology SSDs. 

 

Figure 2.19. Classical hard disk (left) vs. solid state hard disk (right) 

As of 2016, the primary competing technology for secondary storage is flash memory in the form of 

solid-state drives (SSDs), which have higher data transfer rates, better reliability and significantly 

lower latency and access times, but HDDs remain the dominant medium for secondary storage due to 

advantages in price per bit and per-device recording capacity. However, SSDs are replacing HDDs 

where speed, power consumption and durability are more important considerations. 

Hybrid drives (SSHDs) are a logical or physical storage device that combines NAND flash solid-state 

drive (SSD) with hard disk drive (HDD) technology, with the intent of adding some of the speed of SSDs 

to the cost-effective storage capacity of traditional HDDs. The purpose of the SSD in a hybrid drive is 

to act as a cache for the data stored on the HDD, improving the overall performance by keeping copies 

of the most frequently used data on the SSD. 

There are two main technologies used for implementing hybrid drives: dual-drive hybrid systems and 

solid-state hybrid drives. In dual-drive hybrid systems, separate SSD and HDD devices are installed in 

the same computer, having the data placement optimization performed either manually by the end 

user, or automatically by the operating system through the creation of a "hybrid" logical device. In 

solid-state hybrid drives, SSD and HDD functionalities are built into the same physical storage device, 

by adding a certain amount of NAND flash storage (usually somewhere between 8 to 16 GB) to a hard 
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disk drive. The data placement decisions are performed either entirely by the device (self-optimized 

mode), or through placement "hints" supplied by the operating system (host-hinted mode). 

When choosing a storage device, once you have decided on the technology you desire, the next decision 

should be regarding its form factor, or simply said, its size. All hard disk drives come in two sizes: the 

smaller 2.5” (inch) for laptops and the larger 3.5” for desktop PCs. However, SSDs are often produced 

only in a 2.5” form factor and sold with adaptor kits (some hinges and screws) to extend their size for 

desktop PC cases. 

Of course, the available storage space (capacity) is then the most important factor that you will take 

into account. The higher the capacity of the drive, the more information you will be able to store. 

To be noted, that the cost per storage unit for SSDs is about 1.5 to 2 times higher2 than for classical 

HDDs. For example, the classical HDD presented in Table 2.4 costs $53, while the SSD is $79. 

Table 2.4. HDD and SSD characteristics (www.newegg.com) 

Model 

Type HDD SSD 

Brand Western Digital Mushkin Enhanced 

Series Blue Reactor 

Model WD10EZEX MKNSSDRE1TB 

Performance 

Interface SATA 6.0Gb/s SATA III 

Capacity 1 TB 1 TB 

RPM 7200 n/a 

Cache 64 MB n/a 

Dimensions 

Form factor 3.5” 2.5” 

 

For mechanical hard drive, the rotation speed (measured in rotations per minute, RPM) is a factor that 

should also be taken into account. These are generally either 5400 RPM or 7200 RPM, the later one 

being obviously faster. 

 
2 at the time of editing this book (July 2024) 
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Connecting any hard drive to a motherboard should not be an issue, the only type of connector being 

commercially available for consumer use being the SATA interface, with its fasters variant being the 6 

Gb/s version. A compact connector used in modern SSDs, supporting both SATA and NVMe protocols 

is the M.2 connector.  

Video Card 

A video card (also called a video adapter, display card, graphics card, graphics board, display adapter, 

graphics adapter or frame buffer) is an expansion card (and therefor optional) which generates a feed 

of output images to a display (such as a computer monitor). Frequently, these are advertised as 

discrete or dedicated graphics cards, emphasizing the distinction between these and integrated 

graphics. 

 

Figure 2.20. MSI GeForce GTX 960 video card 

The video card contains a specialized processor called a graphical processing unit (GPU) and video 

RAM. The performance of the video card will be mainly limited by these two components. The faster 

the GPU clock speed and the more video RAM the card has installed, the better performances you can 

expect.  

Two other aspects which should also be noted are the maximum resolution supported and the ports 

the video card has. These two factors will limit the choice of monitors which you can connect to your 

PC. Mainly, the higher the supported resolution, the better the displayed image will be. Regarding the 

ports, the monitor and the video card should have the same type of connector in order to be compatible 

with each other.  
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Also important is the fact that the video card needs to be compatible with at least one of the expansion 

slots available on the motherboard. Video cards usually connect to the motherboard via a PCI Express 

interface, however, the versions of these should match.  
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Table 2.5. MSI GeForce GTX 960 characteristics (www.newegg.com) 

Model 

Brand MSI 

Model GTX 960 GAMING 4G 

Interface 

Interface PCI Express 3.0 x16 

Chipset 

Chipset manufacturer NVIDIA 

GPU GeForce GTX 960 

Core clock 1241 MHz 

Boost clock 1304 MHz 

Memory 

Effective memory clock 7010 MHz 

Memory size 4 GB 

Memory interface 128-bit 

Memory type GDDR5 

Ports 

HDMI 1 x HDMI 2.0 

Multi-monitor support 4 

DisplayPort 3 x DisplayPort 1.2 

DVI 1 x Dual-link DVI-I 

Maximum Resolution 4096 x 2160 

Monitor 

A computer monitor or a computer display is an electronic visual display for computers. A monitor 

usually comprises the display device, circuitry, casing, and power supply. The display device in modern 

monitors is typically a thin film transistor liquid crystal display (TFT-LCD) or a flat panel LED display, 

while older monitors used cathode ray tubes (CRT). It can be connected to the computer via VGA, DVI, 

HDMI, DisplayPort or other proprietary connectors and signals. 
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As stated before, the connector of the display should match where the display will be connected: either 

the video port on the motherboard or on the video card. 

 

  
 

  
 

 

VGA connector DVI connector HDMI connector 
DisplayPort 

connector 

Other characteristics that should be taken into account when choosing a display are the: 

• Size 

• Resolution 

• Refresh rate 

• Number of colors displayed 

• Contrast ratio 

• Response time 

The screen size (or display size) is the physical size of the area where pictures and videos are 

displayed. The size of a screen is usually described by the length of its diagonal (usually in inches), 

which is the distance between opposite corners. 

All LCD screens are built with a fixed quantity and size of display pixels (as seen in Figure 2.21). This 

fixed quantity and size of pixels is called native resolution, equivalent to the recommended resolution 

or the maximum resolution. The recommended resolution uses all of the pixels in the LCD screen 

exactly as it was engineered. 
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Figure 2.21. LED monitor: pixels zoomed in 

To display moving images, a monitor must change the displayed image at least 24 times per second to 

be perceived smoothly by the human eye. This is what we mean when we say the television refreshes 

the image - it has to draw images in pixels so quickly that the human eye can't detect the process. 

Refresh rate is the number of times per second in which the display draws the data it is being given. 

For example, a television with refresh rate of 60 hertz means the screen displays an image 60 times 

every second. The more often it does this, the more fluent the motion can be. However, a refresh rate 

higher than 100-150 Hz can be overkill and a waste of money, as at higher frequencies the human eye 

will no longer tell the differences. 

The contrast ratio is the measure of a display system, defined as the ratio of the luminance of the 

brightest color (white) to that of the darkest color (black) that the system is capable of producing. The 

higher the contrast ratio, the more brilliant the display. 

The response time is the amount of time a pixel in an LCD monitor takes to go from black to white, and 

back to black again, measured in milliseconds. Typically, lower numbers mean faster transitions, and 

therefore fewer visible image artifacts. The black-white-black is the typical response time for an LCD 

display and is the ISO standard for this specification. The GTG response time, which means grey to 

grey, is far more common in practice. 

Keyboard and Mouse 

The keyboard and mouse are the two most popular devices used to input data into a personal 

computer.  

A computer keyboard is a typewriter-style device which uses an arrangement of buttons or keys to act 

as a mechanical lever or electronic switch. It typically has characters engraved or printed on the keys 
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and each press of a key typically corresponds to a single written symbol. However, to produce some 

symbols requires pressing and holding several keys simultaneously or in sequence. While most 

keyboard keys produce letters, numbers or signs (characters), other keys or simultaneous key presses 

can produce actions or execute computer commands. 

 

Figure 2.22. Cooler Master CM Storm Octane Gaming Keyboard and Mouse Bundle 

Despite the development of alternative input devices, such as the mouse, touchscreen, pen devices, 

character recognition and voice recognition, the keyboard remains the most commonly used device 

for direct (human) input of alphanumeric data into computers. 

In normal usage, the keyboard is used as a text entry interface to type text and numbers into a word 

processor, text editor or other programs. In a modern computer, the interpretation of key presses is 

generally left to the software. A computer keyboard distinguishes each physical key from every other 

and reports all key presses to the controlling software. Keyboards are also used for computer gaming, 

either with regular keyboards or by using keyboards with special gaming features, which can expedite 

frequently used keystroke combinations.  

A computer mouse is a pointing device (hand control) that detects two-dimensional motion relative 

to a surface. This motion is typically translated into the motion of a pointer on a display, which allows 

for a fine control of the graphical user interface. 

Physically, a mouse consists of an object held in one's hand, with one or more buttons. Mice often also 

feature other elements, such as touch surfaces and "wheels", which enable additional control and 

dimensional input. 
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Figure 2.23. PS/2 connectors (violet - keyboards, green - mouse) and USB connectors below 

Choosing a keyboard and a mouse is most of all a personal preference and as a result will be not 

discussed in detail. However, important aspects when choosing a keyboard are its layout and language, 

while the selection of a mouse is often guided by its sensitivity (measured in dots per inch, DPI). Older 

keyboards and mice connect on a PS/2 interface, while new designs often connect via USB. 

Power Supply Unit (PSU) 

A power supply unit (PSU) converts mains AC to low voltage regulated DC power for the internal 

components of a computer. Modern personal computers universally use a switched-mode power 

supply. Some power supplies have a manual selector for input voltage (110V/230V), while others 

automatically adapt to the supply voltage. 

Most modern desktop personal computer power supplies conform to the ATX specification, which 

includes form factor and voltage tolerances. While an ATX power supply is connected to the mains 

supply, it always provides a 5 V standby (5VSB) voltage so that the standby functions on the computer 

and certain peripherals are powered. ATX power supplies are turned on and off by a signal from the 

motherboard. They also provide a signal to the motherboard to indicate when the DC voltages are in 

specification, so that the computer is able to safely power up and boot.  
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Figure 2.24. An ATX power supply unit with the cover removed 

The most important factor when selecting a power supply is calculating the power needs of your 

computer at peak usage and then adding a safety overhead. This means adding together the peak 

power consumption of all the components powered from the PSU: motherboard, CPU, GPU, etc. 

(however, not the monitor, which is always powered separately) and then adding to that about a 50% 

safety margin. The resulting power rating is the minimum power rating for the PSU that is needed for 

the given system. Most power supplies range from 400W to a staggering 1200W. 

Final considerations 

Now that we know what each component does, how to select it to be compatible with our assembly 

and what to pay attention to in order to achieve top performance, all we need to do is mount the 

components together in order to obtain our desktop PC. This should be a fairly straightforward task 

and if the components are compatible, everything should fit snugly together. 

At this point your PC should power on, all the fans should be spinning, and if everything is connected 

correctly a message should appear on the monitor saying, “Missing operating system” or 

“Operating system not found.” This is because, in this chapter we only took care of the 

hardware, however we have not yet installed an operating system (or anything in fact) on our newly 

built PC. 
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Figure 2.25. Assembled PC (side cover removed) 

Although generally not recommended, powering up a custom-built PC for the first time 

should be done with the case open. This way you can make sure that all fans are spinning, 

and the processor is being cooled. If the system powers on but the fans are not spinning, 

safely power off the system as quickly as possible by pressing and holding the power button. 

Then check again if your fans are correctly connected to the PSU. Do not run your system 

without working fans as this may damage your processor! 

Also, do not place your hand inside the case, attach or remove components as long as the 

computer is powered on and the mains cable in connected. Always unplug the mains cable 

from the PSU before handling components! 

In this chapter we have learnt what are personal computers, how their architecture is structured and 

what are the components that go inside a PC. We have also studied each component in depth, taking a 

look at their most important characteristics. We studied how to get the most out of our hardware 

performance and how to always ensure compatibility between the components. 

In the next chapter we will take a look at how an operating system works, how to install and configure 

it and how to troubleshoot most common problems.
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C h a p t er  3  

 

An operating system, commonly referred to as OS, is a collection of software that manages computer 

hardware resources and provides common services for computer programs. For hardware functions 

such as input and output and memory allocation, the operating system acts as an intermediary 

between programs and the computer hardware, although the application code is usually executed 

directly by the hardware and frequently makes system calls to an OS function or is interrupted by it. 

Operating systems are found on many devices that contain a computer – from cellular phones and 

video game consoles to web servers and supercomputers. 

The most widely used operating systems are produced by Microsoft and are marketed under the brand 

name “Microsoft Windows”. The most common versions of this OS are Windows 10 (support ends 

October 2025), (less popular but still present in some systems), Windows 10 (widely used in both 

personal and business environments) and the most recent version, Windows 11. Initially, Microsoft 

announced that Windows 10 would be the “last” version of its operating system, shifting to a model 

called "Windows as a Service" (WaaS). This approach moved away from traditional, distinct version 

releases and instead delivered regular updates that introduced new features, enhancements, and fixes. 

In April 2017, Microsoft stated that these updates would be released twice a year, in March and 

September. With the introduction of Windows 11, Microsoft continued this update model, labeling 

mainstream builds as "YYH1" or "YYH2," where "YY" represents the release year, and "H1" or "H2" 

indicates whether the update was issued in the first or second half of the year. For instance, version 

23H2 was released in the second half of 2023. 

In this chapter 

o General presentation of operating systems 

o Operating system types 

o Functions and components of the operating system 

o Installing an operating system 

o Troubleshooting tricks and tips 
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However, this changed with the release of Windows 11 in October 2021. Windows 11 introduced a 

new interface, enhanced performance, and other improvements, indicating that despite the original 

plan for Windows 10 to be the "last" version, evolving technology and user expectations led to the 

development of Windows 11. 

 

Figure 3.1. OS common features 

Other operating systems for desktop devices include “macOS” by Apple and various distributions of 

the “Linux” operating system.  
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Figure 3.23. Desktop OS market shares as of 
September 2024 

 

Figure 3.3. Mobile OS market shares as of 
December 2023 

For mobile devices the most common operating systems used worldwide are Google’s “Android” and 

Apple’s “iOS”.  

Operating system types 

Operating systems are generally divided into three major categories: 

1. Single-tasking operating systems 

2. Multi-tasking operating systems 

3. Real-time operating systems 

The difference between the first two classes of operating systems is that while a single-tasking OS can 

run one program at a time, a multi-tasking operating system will allow more programs (or processes) 

to be run concurrently. This is achieved by employing a technique called time-sharing, where available 

processor time is divided between multiple processes. These processes are each interrupted 

repeatedly in time slices by a task-scheduling subsystem of the operating system. Multi-tasking may 

be characterized in preemptive and co-operative types. In preemptive multitasking, the operating 

system slices the CPU time and dedicates a slot to each of the programs. Unix-like operating systems, 

such as Solaris and Linux—as well as non-Unix-like, such as AmigaOS—support preemptive 

multitasking. Cooperative multitasking is achieved by relying on each process to provide time to the 

other processes in a defined manner. 16-bit versions of Microsoft Windows used cooperative multi-

tasking. 32-bit versions of both Windows NT and Win9x used preemptive multi-tasking. 
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Of course, as we have seen in the previous chapter, modern processors have a multicore, multithread 

hardware configuration and therefore provide major advantages to multitasking. While a single core 

processor can run only one process at a time, a quad-core processor will be able to run four parallel 

processes at any given moment, without those processes interrupting one another. Moreover, a 

processor that is able to run multiple threads in parallel on a single core, will also provide additional 

performance boosts to applications which are able to run on multiple threads. Therefore, and Intel i9-

9820X Skylake processor, which is a 10-core processor with capabilities of running two threads per 

core, will be able to run 20 threads in parallel, without having to rely on time-sharing between these 

threads. 

Real-time operating systems, on the other hand, are operating systems that guarantee to process 

events or data by a specific moment in time. A real-time operating system may be single- or multi-

tasking, but when multitasking, it uses specialized scheduling algorithms so that a deterministic nature 

of behavior is achieved. An event-driven system switches between tasks based on their priorities or 

external events while time-sharing operating systems switch tasks based on clock interrupts. These 

types of operating systems are used in specialized applications, such as the automotive or aeronautical 

industry, where response time to a given event is time critical. For instance, in the case of an operating 

system running on the control unit (ECU) of a car, if the antiskid sensor senses that the wheels of the 

car have locked up during braking, it must employ ABS (antilock braking system) techniques to control 

the skid in a given amount of time. This means that the OS, in this case, has to act in a limited and well-

defined amount of time (for example 50 milliseconds) to the data it is receiving.  

Functions and components of the operating system 

Any operating system has the following main functions: 

• Provide communication between the user and hardware. 

The OS must facilitate that the intentions of the user, expressed via the input devices, 

are registered, processed and responded to adequately by the hardware. 

• Control program execution. 

The OS must make sure that the programs running on the users’ device are 

performing as expected, and if they stop responding, crash, or otherwise misbehave, 

it is the operating systems job to gracefully handle the unexpected event (force-close 

the program and inform the user of the problem). 

• Ensure optimal resource allocation. 

The OS is responsible for allocating CPU time, cores, threads as well as RAM memory 

to any running process, based on the needs of the given process and the available 

hardware resources. The OS should prioritize resource allocation for applications 

with which the user is currently interacting and set background applications to have 

low priority resource access if these are scarce. 

• Facilitate efficient data processing. 

The OS should ensure all the users’ data is processed as expected. 
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• Ensure system security. 

The OS should also protect the system of unauthorized access and ensure that the 

users’ sensitive information is only available to the user logged in with the proper 

credentials. Within this category also falls the protection from computer viruses, 

which is primarily the operating system’s responsibility.  

• Enable application development. 

The vendor of the OS should enable programmers to develop applications to run 

under the given operating system. The easier it is for developers to create 

applications for a given OS, the more applications will be available and therefore the 

more popular the OS in question will be. 

The two main components of an operating system are the core, also known as the kernel, and the user 

interface, commonly referred to as the shell. The kernel contains the necessary programs for optimal 

resource management and for controlling the activity of programs and applications and is generally 

not visible to the user. The shell, on the other hand, is the software interface that provides the user 

access to the services of the kernel and is generally an interface with which the user interacts. The 

shell can be presented either in a text-like form (such as a command prompt, where the user inputs 

commands) for simple operating systems or in the form of a GUI (graphical user interface) with which 

the user can interact either by using a keyboard, a mouse or by touches or gestures. 

Installing an operating system 

In order to install (or re-install) an operating system on your computer, you should adhere to the 

following checklist:  

1. Determine the bitness of your CPU. 

2. Download the appropriate OS. 

3. Create the installation (bootable) media for your device. 

4. Boot your device from the media created in step 3 

5. Select the necessary options for your installation. 

6. Optionally, create hard drive partitions (if installing on a brand-new system) and install the 

OS on the appropriate partition. 

7. Configure the OS at first launch. 

8. Check and install any important updates, before installing any other applications 

Determining the bitness of your CPU should be quite straightforward, as most modern CPUs are 64-

bit versions, so it is very unlikely that you would encounter a 32-bit processor, unless you are working 

with a specialized embedded system or a very antiquated one. However, based on your CPU make and 

model, a quick internet search should tell you whether you are using a 32- or 64-bit processor. 

A more important part is downloading the OS with the correct bitness from your vendor. 32-

bit versions will usually be marked as “x86” and the 64-bit distributions will be marked as 
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“x64”. This step is especially important to get right, because a 32-bit OS can be installed on 

a 64-bit machine, however, it will not take advantage of the full power of the processor. For 

instance, a 32-bit OS can only address about 4 GB of RAM, so no matter how much RAM your 

system has (16 GB, 32 GB), if you install a 32-bit OS, only about 4 GB will be usable.  

 

Figure 3.4. Windows USB/DVD Download Tool 

 

Figure 3.5. Windows 10 Media Creation Tool 

Most vendors provide clean ISO images of their operating systems on their websites/webstores. All 

you need to do is download the appropriate image and make sure you have a valid license key, to be 

used later in the installation process. 

Once you have your ISO image, you need to create an installation media. For this you can either burn 

a DVD or create a bootable USB flash drive. In order to create installation media for Microsoft Windows 

installation, you can use either the “Windows USB/DVD Download Tool” or the “Windows 10 Media 

Creation Tool”.  These tools are straightforward to use: all you need to do is download them, install 

them on an already working PC and then follow the step-by-step instructions on the screens of the 

tools. 

Now that you have your media, all you need to do is insert it on the device you want to install your OS 

on, and then make sure the device uses the given media as its primary boot device. This can be 

configured from the BIOS/UEFI of your device. However, most devices also offer a “Quick boot” menu, 

which can usually be accessed by hitting the F12 key, while the device is starting. This will display a 

menu with all available boot devices, from which you can select the media you have inserted in order 

to boot from that. 



Applied Informatics 

49 

 

Figure 3.6. Examples of Quick Boot menus 

After the installer has loaded, you will be greeted by a welcome screen and then you can choose a 

number of options, such as the language, keyboard layout, time zone, etc. You will be also asked to 

provide a valid serial number for your OS license. 

Finally, you will be asked to select on which disk/partition to install the operating system. At this stage, 

if you have a brand-new device, there will be no partitions created, so you will need to create at least 

one. However, you do have the option to create more than one partition. Disk partitioning itself is the 

act of dividing a hard disk drive into multiple logical storage units referred to as partitions, to treat 

one physical disk drive as if it were multiple disks, so that different file systems can be used on each 

partition. It is recommended to create at least two partitions: one called a “system partition”, where 

the OS and all your programs will be installed, and a “data/storage partition”, where you will store 

your other data such as documents, photos and everything else. Note that the installer will probably 

create additions “System Reserved” partitions. Do not delete or modify these, as these contain 

important information for the OS on how your drive is structured and how files are stored on it. 

Deleting these partitions will surely result in data loss! 
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Figure 3.7. Unallocated disk space (no 
partitions created) 

 

Figure 3.8. Two usable partitions and one 
“system reserved” partition 

Note that after creating the partitions, the partition selected (marked with blue), will be the 

partition on which the OS will be installed when you click “Next”. In the case of Figure 3.8 for 

example, this will be “Drive 0 Partition 3”. So, make sure you have the appropriate partition 

selected on which you want to install the OS, before proceeding to the next step.  

Finally, the operating system should be installed, restarting the device in the process a couple of times. 

After this, you will be greeted by a welcome screen, where you will be required to setup your username 

(or online account), Wi-Fi and other settings, amongst which, most annoyingly how Microsoft 

processes your personal data and delivers advertisements to your device.  

Troubleshooting 

The most common problems after installing a new operating system are missing device drivers for 

some of your hardware components. However, these can be easily identified by inspecting the “Device 

Manager”. The “Device Manager” will highlight any problematic devices by placing a yellow 

exclamation mark next to them (as in Figure 3.9). In order to fix such problems with devices showing 

errors, you can try the following steps: 

• Right-click on the device and select “Update driver” and then select “Search automatically for 

updated driver software”. 

• If a driver CD/DVD was shipped with your system, use that specific media to install the 

appropriate device drivers. 

• Identify your device make and model, or better yet, its service tag, and search on the 

manufacturer’s website for up-to-date device drivers. 
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Figure 3.9. Device Manager showing unknown devices 

If neither of the troubleshooting steps managed to solve the problem with your inoperable device, then 

it may be that there is a hardware problem with the device in question. Try replacing it with the same 

or compatible device and see if that solved the issue. When all devices are installed and working 

correctly, the “Device Manager”, by default, should not have any expanded nodes and none of the 

devices should have the yellow exclamation mark next to them.
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C h a p t er  4  

 

Microsoft Word is a word processor developed by Microsoft. It is the most popular word processor 

and is part of either Microsoft’s Office line or its subscription-based services, known as Office 365. 

In this chapter, you will learn how to work with the Word interface, format text, tables and pictures, 

create styles, templates and many more. 

Word user interface 

The Word user interface, as seen in Figure 4.1, is divided in the following areas: 

• The title bar 

• The Ribbon Interface 

• The editing area 

• The status bar 

In this chapter 

o Microsoft Word and Office 365 

o Word user interface 

o Configuring and setting up Word 

o Formatting and styles 

o Working with pictures and images 

o Cross-referencing and citing references 

o Inserting equations 

o Reviewing work 



Applied Informatics 

53 

• The reading pane 

 

Figure 4.1. Microsoft Word user interface (UI) 

The title bar 

The title bar (Figure 4.2) itself is also divided in the following blocks: 

• Autosave status – allows the user to enable/disable the autosaving of the document. When 

this feature is enabled, there is no need to manually save the document, all changes will be 

automatically saved as the document is edited (on the fly). To be noted, however, that this 

feature can only be enabled if the document is saved in a cloud environment, such as Microsoft 

OneDrive. 

• Quick access toolbar (QAT) – allows quick access to the most frequently used commands. The 

QAT is customizable, the user can add/remove buttons to it by clicking the downward 

pointing arrow right at the end of the toolbar. 

• Current document title – shows the title of the current document. 

• Search bar – allows searching for information within the document, recently opened 

document or within the user’s organization (if logged on with an account belonging to an 

organization). 

• User information – displays the currently logged on user (if any). 
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• Ribbon display options – allows the user to hide/show the Ribbon Interface, or to set it to 

automatically be displayed only when it is hovered over with the mouse. This is especially 

useful on smaller devices, since hiding the Ribbon Interface will grow the editing area.  

 

Figure 4.2. The components of the title bar 

Try customizing the Quick access toolbar by adding the following commands: Spelling 

and Grammar, Quick Print. 

By using the ribbon display options button, try the different display options for the 

Ribbon Interface and see which one best suits your liking. The same effect can also be 

achieved by using the shortcut keys Ctrl+F1 to cycle through the display modes.  

The Ribbon Interface 

The Ribbon Interface consists of the tab row, which contains all the available editing options through 

which you can cycle, such as “Home”, “Insert”, “Layout”, etc. The tab row is also contextual, meaning 

that not all commands are available all the time. For instance, the picture formatting commands only 

show up in the tab row if you have actually selected a picture that can be formatted in your document. 

On the Ribbon Interface commands are also grouped into so called groups or chunks. These are usually 

grouped by function, so font formatting command will make up one chunk, then paragraph formatting 

commands another one, and so on. 

To be noted however, that the Ribbon Interface only displays the most widely used commands and 

therefore many of the more advanced commands are hidden from plain sight. In order to get to these 

commands, the user can press on the small dialog box launcher command, present in the bottom right 

corner of most groups. As the name suggests, this will launch a dialog box, where all of the available 

formatting commands for the given topic can be found. For example, the paragraph formatting dialog 
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box, which is displayed by clicking the dialog box launcher marked in Figure 4.3, can be seen in Figure 

4.4. 

 

Figure 4.3. The Ribbon Interface 

 

Figure 4.4. Paragraph formatting 
dialog box 

The status bar and reading pane 

The status bar and reading pane can be found on the bottom margin of the Word window. The status 

bar offers more than 20 optional pieces of information that can be displayed. It can be customized by 

right clicking and then selecting the desired information to be displayed (Figure 4.5). 

 

Figure 4.5. Status bar customization options 
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The reading pane offers a “Focus” button, which, when activated, Word will hide all formatting 

toolbars and ribbons, displaying only a white document. This feature can be used, as the name 

suggests, to focus only on writing the document you are creating, rather than formatting it. Other 

reading modes available are “Read Mode”, “Print Layout” – which is the default view, and “Web 

Layout”. Also here is where you will find a zoom controller, which helps you zoom in/out of your 

document. However, it is worth remembering that zooming in/out can also be achieved by holding the 

Ctrl key on your keyboard and then scrolling the mouse wheel up or down. 

The MiniBar 

The MiniBar (Figure 4.6) is displayed automatically whenever the user selects text (alone) or together 

with the context menu on right clicking anywhere within the editing area. 

 

Figure 4.6. The MiniBar (top) and context menu (bottom) 

The purpose of the MiniBar and the context menu is to display the most frequently used formatting 

and edition commands as close to the cursor as possible. This way, mouse travel across the screen is 

minimized and efficiency increases. 

Configuring Word 

Before actually starting editing documents in Word, there are a few settings you should inspect and 

maybe change to your liking. In order to do this, you should open the “Word Options” panel by 

accessing “File > Options”. Here, you will find the following pages and settings: 

• General – for configuring UI, user and startup options. 
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• Display – for configuring the display of non-printable characters and a few printer options. 

• Proofing – for controlling Autocorrect and Spelling and Grammar settings. 

• Save – for setting up where backup copies of documents are automatically saved and how 

often Word autosaves the document. 

• Language – for controlling Word display language. 

• Ease of Access – for configuring options for users with disabilities 

• Advanced – the vastest page on the Options page, for configuring advanced editing options, 

how cut, copy and paste operations behave, the size and quality of images stored in your 

documents, display and measurement units’ options and layout settings. 

• Customize Ribbon – for customizing the commands that can be seen on the Ribbon Interface. 

• Quick Access Toolbar – for customizing the commands on the Quick Access Toolbar. 

• Add-Ins – for viewing and managing Microsoft Office add-ins. 

• Trust Center – helps keep your document safe and secure. 

 

Figure 4.7. The "Save" page in Word Options 

Before you get started with Word, check and possibly change the following options: 

• Set the “Save AutoRecover information every: x minutes” to a value that is 

satisfactory for your typing speed, so that in the case Word crashes or there is a 
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power outage, you do not lose more than 2-4 paragraphs of text. Take care, 

however, because setting this interval to a too frequent value (such as 1 minute) 

will cause Word to save the document way too often, which in case of large 

documents can be annoying (since depending on the speed of your computer, 

Word will very likely stop responding to your inputs for a few seconds, every 

time it saves the document) 

• Under the “Advanced” page’s “Display” section, check the units of measurement 

used by Word. Change it to whatever suits your needs (inches, centimeters, 

millimeters).  

• Also, on the Ribbon interface, navigate to the “View” page and in the “Show” 

group, check to enable the “Ruler”, which will show the horizontal and vertical 

rules in the editing area (Figure 4.8). This will come in handy later on. 

 

 

Figure 4.8. Horizontal and vertical rules enabled 

Character formatting 

Word has four levels at which formatting can be applied: character formatting, paragraph formatting, 

section formatting and document formatting. As the name suggests, character formatting will apply 

the formatting settings only to a single character. 

There are at least six ways of applying various kinds of character formatting: 

• Using the Font group on the Home tab of the Ribbon (Figure 4.9) 

• Using the Font dialog box (Figure 4.10, accessed by pressing Ctrl+D or Ctrl+Shift+F, or clicking 

the Font Dialog Box Launcher)  
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• Using the Mini toolbar (hover the mouse over selected text) 

• Using shortcut keys (Ctrl+B for bold, Ctrl+I for italics, etc.) 

• Using the Font group or components placed on the Quick Access Toolbar (QAT) 

• Using the Language tool on the status bar (Figure 4.11) 

 

Figure 4.9. The Font group on the Home tab of the 
Ribbon interface 

 

Figure 4.10. The Font dialog box 

 

Figure 4.11. The Language tool on the status bar 

Note: Language is applied at the character level, 

rather than on a word or paragraph level in 

Word! 

There are also at least three ways of repeating/copying character formatting from one place to the 

other: 

• Pressing the F4 key on your keyboard will repeat the last (but only the last) formatting 

command applied. For instance, if you have applied a bold, italics formatting beforehand, 

selecting another word and hitting F4 will apply the italics formatting to the selected word. 

• By using Ctrl+Alt+C you can copy formatting from the area where the cursor is located and 

then by selecting other text, you can paste only the formatting by pressing Ctrl+Alt+V. This 

will copy and paste all formatting. So, for instance, if the text where the cursor was located 

when you pressed Ctrl+Alt+C was formatted as bold, italics and red, the text you paste the 

formatting will have all these properties: it will become bold, italics and red. 

• In the “Home” section of the Ribbon interface, in the “Clipboard” group, there is a “Format 

Painter”. This is able to pick up formatting from the current location of the cursor and then 

“paint” the same formatting to any text it is dragged over. By default, the “Format Painter” will 

deactivate after one use (one application of the format). To keep it active for several uses, 

double click the “Format Painter” button. This will keep the tool active until you deactivate it 

(by clicking the “Format Painter” button again). The “Format Painter” can also be seen in 

Figure 4.9. 
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Direct character formatting is recommended only for singular usage! If you are applying the 

same formatting in more than one place in your document, you should define and use a “Style” 

(see the appropriate chapter in this book). 

Create a document with random text and apply the formatting seen in Figure 4.12. Don’t 

forget to use the formatting replicating tools presented above, when needing to copy 

formatting in more places. 

You can generate a document with random text in Word by opening an empty document 

and then typing “=rand(x)” and hitting “Enter”, where you replace x with the number of 

paragraphs of random text you want to generate. For example, typing “=rand(10)” and 

hitting “Enter” in an empty document, will generate 10 paragraphs of random text.  

Also, you can use =rand(x,y) to generate a specific number of paragraphs and sentences 

per paragraph of random text (x represents the number of paragraphs and y represents 

the number of sentences per paragraph). For example, typing “=rand(3,5)”  and pressing 

“Enter” will create 3 paragraphs, each containing 5 sentences. This gives you more 

control over the structure of the generated text. 

Similarly, you can use “=lorem(x)” or “=lorem(x,y)” if you'd like the same structure but 

with "Lorem ipsum" text instead. 

 

 

Figure 4.12. Create a document and apply the formatting presented in this figure 

Paragraph formatting 

The definition of a paragraph, according to Word at least, is everything that can be found either 

between two paragraph delimiters (also called pilcrows, shown as ¶) or between the beginning of the 
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document and the first pilcrow. This includes all text, images, and tables. So, for instance, the document 

seen in Figure 4.13, will have four paragraphs: one paragraph between the start of the document and 

the first pilcrow, and then three more paragraphs between each pilcrow pair. 

By the way, to see non-printable characters, such as white spaces, tabs and yes, even pilcrows, you can 

use the “Show/Hide ¶” command from the “Paragraph” group of the “Home” tab (Figure 4.14). 

 

Figure 4.13. A document with four paragraphs 

 

Figure 4.14. “Show/Hide ¶” command 

Paragraph formatting can be applied from: 

• The “Paragraph” group of the “Home” tab (Figure 4.15) and the “Paragraph” group from the 

“Layout” tab (Figure 4.17) –Microsoft divides paragraph settings into two tabs to enhance 

organization and usability. The Home tab contains basic, frequently used formatting options 

like alignment and line spacing, while the Layout tab includes advanced settings such as 

indentation and spacing. 

• By using the “Paragraph” dialog box, by clicking the dialog box launcher on either of the two 

groups mentioned above (Figure 4.16). 

When setting up a paragraph, the most common attributes that you will want to consider setting are 

the following: 

• Alignment – determines how the text of the paragraph is aligned relative to the margins of the 

page. 
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o Align left (Ctrl+L) – all text will be aligned to the left side of the page, unoccupied 

space will be left on the right side of the page. 

o Align Right (Ctrl+R) – all text will be aligned to the right side of the page, unoccupied 

space will be left on the left side of the page. 

o Center (Ctrl+E) – all text will be aligned to the middle of the page, unoccupied space 

will be left both on the right and left sides of the page. 

o Justify (Ctrl+J) – all text will be aligned both to the left and right margins of the page, 

unoccupied space will be evenly distributed between the words of the paragraph (for 

example paragraphs in this book are justified). 

 

Figure 4.15. “Paragraph” group on the “Home” tab 

 

Figure 4.16. “Paragraph” dialog box 

 

Figure 4.17. “Paragraph” group on the “Layout” tab 

• Indentation – determines how much space (usually in inches, millimeters, or centimeters) is 

left from the margins of the page until the paragraph text. 

o Left and right – sets the indentation for the whole paragraph. 

o Special – sets the indentation for the “First line” of the paragraph, but also a “Hanging” 

indentation can be set. “Hanging” is a type of indentation where the first line of a 

paragraph is aligned with the left margin, and all subsequent lines are indented. This 

creates a visual effect where the first line "hangs" out to the left of the rest of the 

paragraph. This style is often used in lists of references or citations. 

Note that the indentations are reflected and can also be set on the horizontal ruler. 

 

Figure 4.18. Indentation setup reflected on the horizontal ruler 
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Always indent your paragraphs using the indentation controls available. Never indent your 

text using the “Tab” key or even worse, by using white spaces, since this can cause unexpected 

behavior, especially if you later change the font throughout the document. 

 

• Paragraph spacing – determines how much space (usually in points – pt) is left horizontally 

between each paragraph (1 pt is equal to 1/72 of an inch). 

o Before – sets how much space is left before each paragraph. 

o After – sets how much space is left after each paragraph. 

Note that on adjacent paragraphs, if the spacing set for “before” and “after” do not match, the 

higher value will be used. For example, if we have a paragraph that has “12 pt” set as spacing 

“after” followed by a paragraph that has “24 pt” spacing set as “before”, the horizontal distance 

between the two paragraphs will be “24 pt” (the higher value is applied, rather than the sum 

of the values). 

Always use the paragraph spacing controls available to set horizontal distances between 

paragraphs. Never use empty paragraphs (i.e. adding line breaks by using the “Return/Enter” 

key) in order to distance paragraphs between one another as this can cause paragraphs to 

move around unexpectedly when applying/changing formatting, especially if changing fonts 

later on. 

 

• Line spacing – determines the horizontal spacing between the lines of text within the 

paragraph. By default, line spacing is set at “1.08 pt”, however most professional documents 

(such as articles, scientific journal papers, etc.) will have a specific requirement for line 

spacing, ranging from “single” up to “1.5 lines”.  

• Tabs – determines the exact position a “Tab” character will stop and how the text will be 

aligned respective to that tab character. Tab stops are predefined positions set along the 

horizontal ruler in a Word document, which determine where the cursor moves when you 

press the Tab key. There are different types of tab stops that align text in various ways (Figure 

4.19 and Figure 4.20). This can be used in exceptional cases, when there is no better way of 

setting up a paragraph (Figure 4.21).  
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Figure 4.19. Tab stops setup 

 

Figure 4.20. Tab stops types 

 

Figure 4.21. Aligning and numbering an equation by using tab stops 

Create a document with random text and then format the paragraphs by using the 

techniques presented in the previous two sections, regarding character and paragraph 

formatting as presented in Figure 4.22. 
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Figure 4.22. Character and paragraph formatting exercise 

Section formatting 

In order to apply formatting at a section level, first you must define sections within your document. A 

document can be separated into multiple sections by using “Section breaks” which can be inserted 

from the “Break” button in the “Page setup” group of the “Layout” tab of the Ribbon interface (Figure 

4.23). 

 

Figure 4.23. Section break types 
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Inserting a “Section break” will divide the document into two sections. Further sections can be added 

by inserting additional “Section breaks”. By definition, Word considers a section, everything that is 

found between two “Section break” symbols or between the beginning of the document and the first 

“section break” as well as the last “section break” and the end of the document (Figure 4.24). “Section 

break” symbols can be observed by showing the non-printable characters in the document (Figure 

4.14). 

 

Figure 4.24. A document with three sections 

There are four types of section breaks that can be used: 

• Continuous – will just divide the document into sections, at the point where it is inserted. 

• Next page – will divide the document into sections, but it will also force the text following the 

point of insertion onto a new page. 

• Even page – will have the same effect as the “next page” section break, however, it will force 

the text following the insertion point to be positioned on the next even page (will skip and 

leave blank an odd page, if it is the case). 

• Odd page – will have the same effect as the “next page” section break, however, it will force 

the text following the insertion point to be positioned on the next odd page (will skip and 

leave blank an even page, if it is the case). 

Even and odd page section breaks are especially useful for large documents (such as books), in case 

the user wants a new section (typically a chapter) to begin either on the left- or right-hand side of the 

book. An important thing to be remembered, however, is that if the insertion of an even or odd page 

section break results in the need of an empty page, this will not show up in the Word document as 

an empty page, however it will result in an empty page, when printing the document. For example, 

inserting an even page section break on page 62 of a document will force the text following the section 

break onto page 64. Page 63 will be a blank page, however, it will not show up at all in the document 
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in Word. In this case, when scrolling through the document page 62 will be followed directly by page 

64. But, when printing the document, page 63 will be printed as a blank page. 

Inside a Word document, each section can have separate (and hence different) settings for the 

following: 

• Margins – the space between the margins of the paper and where the text starts/ends. 

Margins can have different settings on all directions: top, bottom, left and right. They can also 

be mirrored when editing bound publications such as books (in which case the inside margins 

should be wider to have enough space for the binding). 

• Orientation – defines the orientation of the pages within the section, between portrait and 

landscape. 

• Size – defines the page size for the section. 

• Columns – sets across how many columns the text is displayed. 

• Line numbering – provides the ability to number the lines within a section. Especially useful 

when documenting computer code, as lines of code can be numbered and then referenced 

later by their number. 

• Hyphenation – tell Word whether to use hyphenation when breaking sentences across the 

page. 

• Headers and footers – usually used to provide navigation information to the user across a long 

document, such as page numbers, chapter or subchapter titles and so on. Headers and footers 

not only be customized for each section separately, but for each section, different headers and 

footers can be defined for odd and even page or the first page of the section (Figure 4.25). 

 

Figure 4.25. Header and footer settings with different headers and footers enabled for the first page 
of the section and for odd and even pages 

When setting up different headers and footers for different sections the “Link to Previous” 

button in the “Navigation” group will be enabled by default. This links the current headers and 

footers of the current section to the ones from the previous section. As a result, all changes 

made in the headers and footers of the current section will be also applied to the headers and 

footers of the previous section. In cases where this is not the desired behavior (for instance, 

if each section wants to have its title in the header), the “Link to Previous” button needs to be 

disabled before making any modifications in the headers and footers. 

When working with a document that contains multiple chapters, each chapter should be 

separated into a separate section, even when all the settings across the chapters are the same. 

This will make any future modifications to the document much easier, as well as enable 
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numbering of chapter titles, figures and tables to contain the chapter number (such as the 

numbering of figures in this book, for example). 

Create a long document (20+ pages) with random text and then perform the following 

operations: 

• Divide the document into three chapters/sections. 

• Set up all chapters to have the paper size of A4. 

• In the second chapter the orientation of the pages is landscape, while in the other 

chapters the orientation is portrait. 

• In the second chapter the text is displayed in two columns across the page, while 

in the other chapters the text is displayed normally, in one column. 

• Insert page numbers in the footer of the document, for each chapter. The 

numbers are aligned to the middle of the page. 

• For each individual chapter, set up the headers as follows: 

o The first page of each chapter does not have any information in the 

header. 

o The odd pages of the chapters contain the chapter title, i.e. Chapter One, 

Chapter Two and Chapter Three, aligned to the right side of the page. 

o The even pages of the chapters contain the imaginary title of your work, 

aligned to the left side of the page. 

Styles 

By using styles, you can make easy and consistent changes across the whole document with a few (or 

even just one) click. This ensures a more organized way of editing and formatting your document as 

well as aids in making changes throughout the document without the need for searching for specific 

sections/paragraphs within it. 

By setting up a style, you can predefine settings to all things related to font and paragraph formatting, 

tab stops, borders, language, frames, numbering and text effects. You can even add a shortcut key to 

your style, which makes it easier to apply. 

Microsoft Word comes with a set of predefined styles. These can be found in the appropriately named 

“Styles” group in the “Home” tab of the Ribbon interface (Figure 4.26). 

 

Figure 4.26. The “Styles” group with predefined styles 
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To be noted however, that these predefined styles might not be to your liking (and honestly, no 

wonder, since they are truly horrendous). But they are a good starting point and luckily then can be 

customized and set up to look just the way we want it. But before we do that, we need to know how a 

few of these styles work. 

First of all, we should bear in mind that all paragraph text in a document (such as this text that you are 

reading), if not modified, by default, uses the “Normal” style defined within the document. This means 

that if we modify the “Normal” style in a document, the modification that we make will be applied to 

all of the paragraphs within the document. 

There are a few other styles which we should use in a particular fashion, in order to get the most of 

our document. For example, “Heading 1/2/3…” styles should always be used to define chapter titles – 

“Heading 1”, subchapter titles – “Heading 2”, and so on. This will make it easier later on to generate an 

automatic table of contents for our document. 

 

Figure 4.27. The dialog box for modifying a predefined style 

Image captions (which we will learn about a little bit later), on the other hand, use the “Caption” 

predefined style. Again, by default, this style is not the prettiest, but we can later modify it to suit our 

needs.  
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All other formatting that you consistently apply to your document should also be defined as a style. 

For example, if you constantly have quotations within your document and you want them to be 

formatted in a specific way (let’s say you want them to use a font that simulates handwriting and are 

aligned more to the middle of the page), you should create a new style for that (or use the build-in 

“Quote” style). If you have text within your document that you want to make it stand out (for instance, 

you want it to be bold), you should define a style for that too (or use the predefined “Emphasis” style). 

So, all formatting that you apply more than once across your document, should be defined as a separate 

style. This way, if you ever change your mind, you can just change the definition of the style, and all 

formatting is applied across the document, without the need of manually reformatting.  

Styles from the “Styles” group can be quickly modified by right clicking on any of them and then 

selecting “Modify”. This will display the “Modify Style” dialog box, where you can directly modify a few 

settings on the main window, however you have access to all the settings of the style by clicking on the 

“Format” dropdown button on the bottom left-hand side (Figure 4.27). 

You can also access the “Styles” task pane (Figure 4.28) by clicking the dialog box launcher button on 

the “Styles group” (Figure 4.26). From here, you can create your own style by using the “New Style” 

button, inspect the style a given element is using by selecting the “Style Inspector” or access additional 

features by using the “Manage Styles” button. 

 

Figure 4.28. "Styles" task pane 

Create a document with a chapter title and 3 paragraphs and format the “Styles” to reflect 

the formatting presented in Figure 4.29. 

Format “Heading 1” as follows: 

• Font: Arial, 26 pt., bold, red 



Applied Informatics 

71 

• Paragraph: justified, aligned to the left by 1 cm, 12 pt. before, 18 pt. after, single 

line spacing 

• Border: 3 pt. red border below the text 

Format the “Normal” text as follows: 

• Font: Arial, 12 pt. 

• Paragraph: justified, first line at 1.5 cm, 0 pt. before, 12 pt. after, line spacing at 

1.5 lines 

Create a new style named “MyQuote” and format it as follows: 

• Font: Brush Script MT, 16 pt., italics, gray 

• Paragraph: justified, 1.5 cm indentation both on the left and right sides, no first 

line indentation, 6 pt. before, 18 pt. after, single line spacing 

 

 

Figure 4.29. Practice exercise 

Now, let’s imagine a scenario where we wake up one morning, and we come to the 

realization that the red title is a little bit too “in your face” and that the font used for 

quotations is really unreadable and that it’s outdated to indent the first lines of 

paragraphs. And now we need to change that throughout the document. If we wouldn’t 

have used styles, this would be a very laborious process, where we would need to change 

each individual paragraph, find all quotations and change their fonts, etc. Luckily, with 

styles, we can change the style definition, and all changes are applied automatically, 

across the whole document. The modified document should now look like Figure 4.30. 

Modify the “Heading 1” style to replace the red font color with green and update the 

border to also be the same shade of green. 

Modify the “Normal” style to remove the first line indentation for paragraphs. 

Modify the “MyQuote” style to use “Lucida Handwriting” as font with the size of 12 pt. 
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Figure 4.30. Modifying styles 

You may encounter difficulties in applying or modifying borders. This is because there is a 

certain order in which the process should be performed. First off, select the “Style” of the 

border, the “Color” and the “Width”. Then, on the “Preview” pane, click where you want to 

apply the border defined (i.e. click below the diagram to apply border below a paragraph). See 

Figure 4.31. 

 

Figure 4.31. Applying borders to paragraphs 
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Pictures and images 

There are several ways of inserting images into a Word document. You can use the “Pictures” option 

from the “Illustrations” group of the “Insert” tab from the Ribbon interface. Alternatively, you can 

either drag-and-drop an image into a document, or you can copy-paste it. However, when inserting an 

image by using the “Pictures” option, you have a little bit more control over how your image is inserted 

into the document by using the dropdown arrow on the “Insert” button (Figure 4.32): 

• Insert – the picture will be embedded (saved inside) the document. This is the default option 

and it is also used when pasting or drag-and-dropping an image into a document. 

• Link to file – only the path of the picture is saved in the document. Whenever the document is 

opened, the path is searched and if the image is found, it is displayed in the document. This is 

great, because in this scenario, the image is updated every time the document is opened. So, 

it is a great way of keeping your images up to date. However, if the image is moved or deleted, 

and it is not found, no image will be displayed. 

• Insert and Link – is both above options combined. Both the path of the image, and the image 

itself are saved in the document. When opening the document, if the image is found in the 

stored path, the image in the document is updated and the updated version is saved. If the 

path is no longer valid, the last saved version of the image is displayed in the document. 

 

Figure 4.32. Picture insert options 
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When working with a picture (a picture is selected), the “Picture Format” tab is available in the Ribbon 

interface (Figure 4.33). This contains the following formatting options and submenus:  

• Remove background – a tool for removing the background color from images. 

• Adjust – several tools for adjusting the look of the image. 

o Corrections – Sharpness, brightness and contrast adjustments. 

o Color – Saturation, tone and recolor options. Also, here you can find a “Set transparent 

color” option, with which you can define a color in an image as being transparent. 

Select this tool and click on any color in the image and that given color will be set to 

transparent. This is also useful for removing white (or any other) background colors 

from images. 

o Artistic Effects – different artistic styles. Note that your Word document is not your 

Instagram account, so you should probably just ignore this feature. 

o Transparency – controls the transparency of the image (duh!). 

o Compress Pictures – will reduce the amount of memory the images take up in your 

document (but it may also reduce image quality, so use with caution!). 

o Change Picture – replace the selected image. 

o Reset Picture – reset all formatting applied to the image. 

• Picture styles – applies borders and other artistic effects to your image. Again, not Instagram, 

so not recommended. 

• Alt Text – alternative text if image is not visible or audio description is used for people with 

disabilities. 

• Position – where the image is placed on the document (usually the default placement is quite 

alright in newer versions of Word, so not necessarily something to change). 

• Wrap Text – how the image and text interact within the document. 

o In Line with Text – the whole image will behave as it were a line of text, it will be 

aligned with the text, on the same line (the bottom of the image) (Figure 4.34). 

o Square – the text will wrap around the image, so multiple lines of text will be 

displayed next to the image (if they fit) (Figure 4.35). 

o Through – the same as “Square”, however, text will also flow inside the transparent 

portions of the image (if it fits). 

o Top and Bottom – no text will be placed near the image and all text will flow either 

above or below the image (Figure 4.36). 

o Behind Text – image will be placed behind the text (the text will cover the image) 

o In Front of Text – image will be placed in front of the text (the image will cover the 

text). 

Figure 4.33. Picture format tab 

• Bring Forward/Send Backward – controls for overlapping images and which overlaps which. 

• Selection Pane – a list of selected images. 
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• Align – aids with aligning multiple images. 

• Group – transforms multiple images into a single group so they can be manipulated together. 

• Rotate – apply rotation or vertical/horizontal translations to the image. 

• Crop – cut out unwanted pieces from the image sides to make the image smaller or remove 

elements which you do not want to show. Note that this operation is non-destructive, so you 

can always have the original image back or lessen the crop, if you wish to do so later on. 

• Height/Width – control the height and width of the image. 

 

Figure 4.34. Image alignment: 
In Line with Text 

 

Figure 4.35. Image alignment: 
Square 

 

Figure 4.36. Image alignment: 
Top and Bottom 

Note that when resizing images via the “Height” or “Width” controls in “Picture Format” tab 

on the Ribbon interface the aspect ratio of the image (meaning the relative height and width) 

is kept constant. This is not the case however, if you decide to resize the image by using the 

mouse and dragging one of its sides/corners. In this case, since you cannot manually drag the 

same amount both horizontally and vertically (unless you are some sort of mouse dragging 

champion), your image will end up distorted. In order to prevent this from happening, and to 

keep a constant aspect ratio, hold the Shift key on your keyboard, while dragging one of the 

corners of the image. Alternatively, you can right-click the image, choose Size and Position, 

and check the Lock aspect ratio box under the Size tab. 

In most cases, when you insert an image in your document, you will want to explain it or talk about it 

in your text. As a matter of fact, you should never insert an image in your document unless you want 

to talk about it (do not use images as filler items, just to make your document longer and meet the 

required length). When you want to reference an image in your document, you should do it by using 

its caption. Which means actually adding a caption to the image, in the first place. 

Captioning an image can be done by right clicking on the image and selecting “Insert Caption…” from 

the dropdown menu. This will display the “Caption” dialog box (Figure 4.37). Here, you can choose the 

label for your image. You can either selected from a predefined list of labels or define your own label 

by pressing the “New Label…” button. For example, in this document, all images are labeled as “Figure”. 

You can also select the position of the caption to be either above or below the image.  

Finally, by using the “Numbering” button you can define the numbering style you want to use, by 

setting the options available in the “Caption Numbering” dialog box (Figure 4.38). Here you can define 
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the numbering style (e.g.: roman numerals, Arabic numerals, etc.) or whether to include or not the 

chapter number. Please bear in mind that to include chapter and subchapter numbers, your chapters 

and subchapters need to be defined using the appropriate heading levels, as discussed in the “Styles” 

section, earlier on. For example, in this document all images include the chapter number when 

captioning images.  

 

Figure 4.37. Caption dialog box 

 

Figure 4.38. Caption numbering dialog box 

Image captions use the predefined “Caption” style by default. This means that modifying the styling of 

image captions is as easy as updating the “Caption” style available in the “Styles” gallery. 

Create a document with random text and several chapters. Remember to delimit 

chapters into separate sections and style chapter titles using the appropriate heading 

styles. Now, insert a few random images across the document. Practice different image 

positioning options. Finally, caption the images. Modify the caption style, so the captions 

are aligned to the middle of the image, they use a black straight font and they include the 

chapter number as well. If set up correctly, your image captions should resemble the ones 

used in this document.  

Cross-referencing 

Cross-referencing helps you to refer to any structural part of a document in your text without the need 

of remembering numbering or where given items are located. Moreover, you can insert references 

without the need to type them out and you can update them with a single step, without the need of 

parsing through the whole document. This way, you can keep your document clean, organized, and up 

to date.  

Take the following scenario. Let’s say you have a very large document, with several tens or hundreds 

of images, all captioned and numbered. Obviously, you refer to those images in your text, by their label 

(e.g.: “Figure 4.37”, “Figure 4.38”). Now imagine that you insert one additional image in the middle of 

your document. Obviously, this will renumber all images in your document, and now, if you typed out 
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the references to the images manually, in your text, all references that follow the newly inserted image 

are wrong. Cross-referencing fixes exactly this problem. 

In order to insert a reference, you need to access the “Insert” tab and then find the “Cross-reference” 

button in the “Links” group of the Ribbon interface (Figure 4.39). This will show the “Cross-reference” 

dialog box. 

 

Figure 4.39. The "Insert" tab of the Ribbon interface 

In the “Cross-reference” dialog box (Figure 4.39) you can choose: 

• Reference type: what type of item are you referencing (headings, figures, tables, etc.). 

• Insert reference to: whether you want to insert the whole caption of the item, only the label 

and number (like in this document, for example), only the caption text, the page number the 

reference is on, or a navigational aid, such as “above” or “below”. 

• Insert as hyperlink: will make the reference clickable, if the user opens the document on a 

computer, they can use “Ctrl+Click” in the reference to navigate directly to it. 

• For which caption: finally, choose the item you want to reference. 

 

Figure 4.40. "Cross-reference" dialog box 
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By using this technique to insert references, instead of directly typing them out, whenever you change 

the numbering of an item or insert additional items, the references will be automatically updated. 

Note that cross-references are not updated instantly. You can manually update one cross-

reference by right-clicking on it and selecting “Update Field” from the menu. All references 

will be updated when printing (or seeing a print preview of) the document. In order to see a 

print preview, and force the updating of all cross-references, navigate to “File” – “Print”. 

Another thing to bare in mind, is that if the item you are cross-referencing was deleted, the 

reference to it also needs to be deleted. If not, a dead reference will result, which will show up 

in the final document as an unfound reference (as seen in the last sentence of Figure 4.41). 

 

Figure 4.41. Missing reference example 

Citing bibliographical references 

Plagiarism, also known as theft of intellectual property, is not only frowned upon, but is also illegal 
and, if detected, will certainly get your work rejected. Therefore, whenever you make a factual 
statement or take results from other sources, you should always cite where that information is from. 
In order to do this, we can use the “References” tab from the Ribbon interface. Here, you will find the 
“Insert Citation” button, which can be used to insert a new bibliographical reference (Figure 4.42). 

 

Figure 4.42. The "References" tab on the Ribbon interface 

Here, you can either choose to insert an already existing source or add a new source by selecting the 

“Add New Source…” option. This will launch the “Create Source” dialog box (Figure 4.43). From this 

dialog box you can select the type of source you are citing (books or journal articles are preferred for 

scientific papers) and then complete the appropriate fields (the more, the better) about your cited 

source. After completing this dialog box and hitting “OK”, the bibliographical reference will be inserted. 

The default style is “APA”, however, in engineering works the “IEEE” style defined by the Institute of 

Electrical and Electronics Engineers should be used. 
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Figure 4.43. "Create Source" dialog box 

Finally, at the end of your document, you should generate the full list of Bibliographical references, of 

Bibliography, as it is commonly called. To do this, you can use the “Bibliography” button from the 

“Citations & Bibliography” group found on the “References” tab (Figure 4.42).  This will generate the 

list of Bibliographical references, as seen in Figure 4.44. 

 

Figure 4.44. Example of an automatically generated list of Bibliographical references 
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Office clipboard 

The “clipboard” is the name of the memory space where applications store the information that has 

been “copied” or “cut” and can later be inserted via a “paste” operation into a document. This memory 

space usually has a “size” of one item, which, let’s face it, can be very small, when working in a large 

document. 

The Office clipboard extends this to a 24-item memory space and allows you to handle multiple items 

at a time. To activate the Office clipboard, you need to press the dialog box launcher button of the 

“Clipboard” group from the “Home” tab of the Ribbon interface (Figure 4.45). 

 

Figure 4.45. Activate the Office clipboard by pressing the marked dialog box launcher 

Once activated, the Clipboard side panel is displayed, from which you can paste the items from the 

Office clipboard by clicking or manipulate them by clicking on the dropdown arrow found near them. 

Also, whenever pasting something in a document, the “Paste Options” button is shown (Figure 4.46), 

which allows you to select from between a number of ways you want to paste your content (e.g.: paste 

only text, but not the formatting, match formatting when pasting, paste as a picture, etc.). 

 

Figure 4.46. Paste Options button 

Inserting equations 

When inserting equations, they should never be edited using plain text, as this not only is 

unprofessional, but most likely will make the equation much more difficult to read and understand. 

Also, if you refer to the equation within your text, then the equations should also be numbered on the 

right-hand side. 
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To insert equations, the “Equation Editor” should be used. This can be found in the “Symbols” group 

of the “Insert” tab of the Ribbon interface (Figure 4.47).  

 

Figure 4.47. The “Insert” tab of the Ribbon interface 

After inserting an equation, the “Equation” tab is available in the Ribbon interface (Figure 4.48). Here, 

you have multiple options to insert and format your equation. The “Symbols” group offers the most 

commonly used mathematical symbols. It also has a dropdown with the help of which you can switch 

to other useful sets, such as Greek letters, operators, arrows and many more. The “Structures” group 

offers ways of adding fractions, scripts and other functions and operators to your equations. 

 

Figure 4.48. Equation editing tools 

Create a Word document and insert the equations presented in Table 4.1.  

 

Table 4.1. Equations to be inserted 

Equation name Integral form Differential form 

Gauss’s law 
∯ 𝐸 ∙ dS =

1

𝜀0
∭𝜌dV

Ω𝜕Ω

 ∇ ∙ 𝐸 =
𝜌

𝜀0
 

Gauss’s law for 

magnetism 
∯ 𝐵 ∙ dS =
𝜕Ω

0 
∇ ∙ 𝐵 = 0 

Maxwell-Faraday 

equation 
∮ 𝐸 ∙ 𝑑𝑙
𝜕Σ

= −
𝑑

𝑑𝑡
∬𝐵 ∙ dS
Σ

 ∇ × E = −
𝜕𝐵

𝜕𝑡
 

Ampere’s law 
∮ 𝐵 ∙ 𝑑𝑙
𝜕Σ

= 𝜇0∬𝐽 ∙ dS + 𝜇0
Σ

𝜀0
𝑑

𝑑𝑡
∬𝐸 ∙ dS
Σ

 ∇ × B = 𝜇0(J + 𝜀0
𝜕𝐸

𝜕𝑡
) 
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Generating automatic table of contents 

Larger documents, those spanning multiple pages or chapters, should have navigation aids to help the 

reader easier find information in the document. In order to do this, you can use headers to include 

chapter and subchapter titles across the document. In addition to this, pages should be numbered. This 

can be done by accessing the “Header & Footer” group from the “Insert” tab of the Ribbon interface 

(Figure 4.49). 

 

Figure 4.49. Inserting page numbering 

Finally, a table of contents should be included either at the beginning or the end of the document. If 

everything was set up according to the expectations of Word (and as presented in the document: 

chapter titles formatted as Heading 1, subchapters as Heading 2, etc.) generating the table of contents, 

can be done with a few simple clicks. You just need to access the “Table of Contents” option from the 

“Table of Contents” group of the “References” tab from the Ribbon interface (Figure 4.50). 

 

Figure 4.50. Generating automatic table of contents 
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If you haven’t set up everything in accordance with the default expectations of Word, you can still 

generate a custom table of contents, by selecting the “Custom Table of Contents…” options from the 

same “Table of Contents” button mentioned above.  

Reviewing documents 

Reviewing your own document 

Before submitting your work, you should always adhere to the following checklist:  

1. Reread your document: although this may seem tiresome, always fully reread your document. 

Very often, our thought process is much faster than we are able to type. This may result in 

forgetting to type whole or half sentences, which makes the idea we are trying to convey, 

unclear. Rereading the document assures us that our ideas are understandable. This also helps 

us proofread our document for spelling and grammar mistakes. 

2. Run the automatic “Check Document” option from the “Proofing” group of the “Review” tab 

from the Ribbon interface. This will check and highlight any spelling and grammar errors in 

your document and generate a report, from which you can then fix these issues.  

 

Figure 4.51. The Check Document button 

3. If you are planning to print your document, save it to PDF beforehand, review the PDF 

document and print from PDF, especially if you print your document from another computer, 

than the original on which you edited your document. PDF ensures that “what you see is what 

you get”, when printing, while printing directly from Word may move around items in your 

document, depending on the settings of the computer you are printing from. To save a 

document to PDF, navigate to the “File” tab, and then select “Save a copy” and from the 

dropdown menu below the document name, select PDF (*.pdf). 

4. Optionally, you can mark the document as “Final” or restrict editing by adding a password. 

These options are available from the “Protect Document” button of the “Info” section of “File” 

tab from the Ribbon interface.  

Reviewing other documents 

When reviewing other people’s documents, you have two options. The more basic one is just to make 

a copy of the original document and then make changes/recommendations in the copy. Then, the 
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original author can use the “Compare” option from the “Review” tab of the Ribbon interface, to see the 

differences between the original and the reviewed document and decide on the final form of their 

work. 

A more advanced way of doing a review, however, is to use the “Tracking” features found in the 

“Review” tab of the Ribbon interface (Figure 4.52).  

 

Figure 4.52. Reviewing tools in Word 

After activating the “Track Changes” button, all changes made to the document are done in a non-

destructive manner and are marked clearly in the document. How much details of the changes made 

in the document are shown, is controlled by the “Display for Review” dropdown option. Showing “All 

Markup” will display all the changes made to the document (Figure 4.53). This way, Word will track 

all deleted, added and modified text and all style and formatting changes and mark them accordingly. 

If you do not wish to make changes to the document, but have some observations, you can add 

comments by using the “New Comment” button. 

 

Figure 4.53. Tracking changes to the document 

Once you finished your review, you can deactivate the tracking of changes, save the document and 

send it back to the original author. Now, all they need to do is to navigate through your changes by 

using the “Previous” and “Next” buttons in the “Changes” group of the “Review” tab and “Accept” or 

“Reject” these by using the appropriate buttons (Figure 4.52).
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C h a p t er  5  

 

Microsoft Excel is a spreadsheet developed by Microsoft. It features calculation, graphing tools, pivot 

tables, and a macro programming language called Visual Basic for Applications. It has been a very 

widely applied spreadsheet for these platforms, especially since version 5 in 1993, and it has replaced 

Lotus 1-2-3 as the industry standard for spreadsheets. Excel forms part of the Microsoft Office suite of 

software. 

In this chapter, you will learn how to work with the Excel interface, create tables, automate 

calculations and formatting, and graphically represent your datasets.  

Excel user interface 

The Excel user interface is very similar to its Word counterpart, however there are some key 

differences. First of all, the cursor that indicates the current position within the text in Word, in Excel 

is replaced by the active cell indicator Figure 5.1). This shows the user which cell is currently active 

and hence which cell the data will be introduced in. An important thing to note here is that each cell is 

referenced in Excel by its row number and column letter. So, for example in Figure 5.2 the active cell 

can be referenced as cell C3. Also note that the cell reference is displayed in the “Name Box”, shown in 

In this chapter 

o Excel user interface 

o Autofill and entering data 

o Formatting cells and creating tables 

o Working with formulas 

o Data validation and conditional formatting 

o Inserting charts and graphs 

o Using macros 
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Figure 5.2 in the top left-hand side. By typing a custom name in this box, a custom cell reference can 

be created. For example, by selecting the “Name Box” and typing “myCell”, now cell C3 can be 

referenced later on either by “C3” or by “myCell”. 

 

Figure 5.1. Active cell indicator in Excel 

 

Figure 5.2. Creating custom cell references 

Finally, several text editing specific tabs in the Ribbon Interface have been replaced by tabs specific to 

data entry, processing, representing, and editing. We will gradually go over the most important of 

these. 

Autofill 

Excel facilitates manual data entry by providing a feature called Autofill. Using this feature the user 

can enter the first few pieces of data from their dataset and then either by dragging or by using the Fill 

command, Excel can “guess” the next pieces of data. 

For using the drag feature for Autofill proceed as follows: 

• Enter the first two or three pieces of data (Figure 5.3). A single piece of data is enough for 

dates, days, or single just to copy data. However, if you want your data to follow a 

mathematical formula, e.g. increment the number 3-by-3, you need to provide the first two 

pieces of data. 

• Select all the cells you have entered data into and then drag the right lower corner of the last 

cell in the direction you want to fill the data (Figure 5.4). 

• Optionally, use the “Auto Fill Options” button to control how the data is filled (Figure 5.6): 

o Copy Cells: Excel will repeat the data in the selected cells, it will not follow a formula 

to try to guess the next pieces of data. 

o Fill Series: Excel will try to guess the next pieces of data and fill them according to 

the formula it estimated. 

o Fill Formatting Only: Excel will only replicate the formatting of the selected cells, 

however data in the cells you dragged over will not be affected. 

o Fill Without Formatting: Excel will only fill the data based on the formula it guessed, 

but will not replicate the formatting of the source cells. 
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o Flash Fill: automatically fills your data when it senses a pattern. For example, you 

can use Flash Fill to separate first and last names from a single column or combine 

first and last names from two different columns. 

 

Figure 5.3. Entering data for 
Autofill 

 

Figure 5.4. Dragging data for 
Autofill 

 

Figure 5.5. Autofill results 

 

 

Figure 5.6. The “Auto Fill Options” button 

Obviously, dragging is not a solution for large sets of data. In this case, you can use the “Fill” option 

from the “Editing” group of the “Home” tab from the Ribbon Interface (Figure 5.7). For using the “Fill 

Series” command (Figure 5.8) you need to: 

• Specify the series starting value in your starting cell and select the cell before calling the 

command. 

• In the command dialog bow specify whether to fill the series in Rows or Columns, the type of 

series you want to use (Linear, Growth, Date or AutoFill) and if needed the Date Unit used.  

• Then specify the Step value and the Stop value (up to which value the data is generated). 
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Figure 5.7. the “Fill” option from the “Editing” 

group of the “Home” tab from the Ribbon 

Interface 

 

Figure 5.8. Fill Series command 

Create the following data series: 

• [-10; 10] with a step of 0.5 

• [-3.14; 3.14] with a step of 0.1 and alternating 

red and green text 

• [0; 100] with a step of 0.005 

The datasets should look like in Figure 5.9. 

 

 

 

 

 

 

 

 

 

 

Formatting cells 

Given the wide range of data Excel is able to process, cells can be formatted to represent data 

differently. Typically, the data type of each cell is set to “General”, meaning that in this case Excel tries 

to guess the type of data presented in the cell and format it accordingly. Most of the times it does a 

decent job, and no intervention is necessary, but there are times where Excel either gets the guess 

wrong, or you want to have a different data representation than the built-in one.  

Figure 5.9. Sample data for 
the proposed exercise 
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Formatting cells can be done by selecting the cells needed to be formatted and the right-clicking and 

accessing the “Format Cells…” option. This will display the “Formal Cells” dialog box (Figure 5.10).  

 

Figure 5.10. Format Cells dialog box 

The “Number” tab will allow you to control how data is displayed in your cell. In Figure 5.11 the 

number 3.14 was introduced in a cell and then each “Category” option was applied manually. Check 

how the displayed result varies based on this selection. 

 

Figure 5.11. Different cell formatting options applied to the same (3.14) value 

Note that by default, Excel will align all numbers to the right side of a cell and all text to the left side of 

the cell. This can be particularly useful when a formula does not function according to expectations 

and you need to check which cells have been parsed as numerical values and which are interpreted as 

text. 
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Figure 5.12. "Alignment" tab from the "Format Cells" dialog box 

Furthermore, you can control the text alignment within your cell by accessing the “Alignment” tab 

(Figure 5.12). Check the “Wrap text” option under “Text control” if you want your text to overflow 

across multiple lines if it does not fit within the width of the cell. All the other options are rather self-

explanatory and will control the horizontal and vertical alignment, or even the angle at which the 

content of the cell is aligned.  

Using the other tabs, you can format the “Font” options, such as the font face, style, size, color, the 

“Border” options, such as style, width and color and of course the “Fill” options for the cell, meaning 

the background color and style. In the “Protection” tab you can protect your cell, which will disable 

any future attempt to modify its contents or hide the cell.  

Tables 

Tables represent the essence of Microsoft Excel. They allow representing data in a compact form, 

filtering, and sorting of data, as well as help increase legibility. To be noted that solitary cells, even 

when formatted to look like a table, do not actually make up a table. In order to have a legitimate table, 

one must be defined. 

To define a table, enter all preliminary data in your rows and columns (Figure 5.14). While it is 

optional, it is always a good idea to also name your columns appropriately: these will be called table 

headers and should state what each column of data represents. Then, navigate to the “Insert” tab of 

the Ribbon Interface and from the “Tables” group, select “Table”. This will launch the “Create Table” 

dialog box (Figure 5.13). Here, the location of the table should already be correct. If your table has a 

header, you should check the appropriate option.  
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Figure 5.13. Create Table dialog box 

 

Figure 5.14. Raw data 

 

Figure 5.15. Data formatted within a table 

After creating a table, the “Table Design” tab will be available in the Ribbon Interface. The two most 

important groups here are the “Table Style Options” and “Table Styles” chunks (Figure 5.16). From 

within the “Table Styles” group you can change the colors and look of the table, while from the “Table 

Style Options” you can control the following: 

• Header Row: Show/Hide the header row. 

• Total Row: Enable/Disable the automatic total row of the table. 

• Banded Rows: alternate the shade of even and odd rows for better legibility. 

• Banded Columns: alternate the shade of even and odd columns for better legibility. 

Do not use both banded rows and columns as this will create a chessboard look and will make 

the table very hard to read! 

• First Column: Highlight (bold) the first column. 

• Last Column: Highlight (bold) the last column. 

• Filter button: Show/Hide the “Filter button” on the Header row. 

 

Figure 5.16. Table formatting options 

Besides increasing eligibility, tables offer two major advantages: they can be easily sorted, and data 

can be easily filtered.  
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Sorting data in a table can be done from one of two places. A simple sorting by a single column can be 

done by using the “Filter Button” (if displayed) on each column header (Figure 5.17). By clicking the 

corresponding “Filter Button” on the column header you want to sort by, you have the option of sorting 

in an ascending or descending order the data in the table by the given column. 

 

Figure 5.17. Using the "Filter Button" to sort or filter table data 

A more complex sorting can be done, by several criteria, using the “Custom Sort…” option from the 

“Sort & Filter” button available in the “Editing” group of the “Home” tab in the Ribbon Interface. By 

using this option, a multi-level sorting mechanism can be defined for your table, as seen in Figure 5.18.  

 

Figure 5.18. Custom multi-level sort by several criteria 

By filtering data, you have the ability to only display a subset of the data from the table, based on one 

or more selection criteria. Filtering can also be accessed by using the “Filter Button” presented in 

Figure 5.17. By using the available checkboxes, you can select the pieces of data you want to include in 

your table. Cells that contain numerical values can be filtered by several criteria using the “Number 

Filters” option (Figure 5.19). 
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Figure 5.19. Filtering cells with numerical values 

Formulas 

Formulas constitute an essential part of Microsoft Excel since they can be used to automate 

calculations in your spreadsheet. Obviously, Excel has several hundreds of built-in formulas and going 

over all of these would be not only very painstaking, but also quite boring, so we are not going to do 

that. What we are going to do, nonetheless, is understand how formulas work, and from then on you 

can either search for a formula that is the most appropriate for your task either in the Help of Excel or 

on Google. 

Formulas are so important that they even get their own separate tab on the Ribbon Interface (Figure 

5.20). Here you can find the “Function Library”, which groups the available formulas by their purpose, 

the “Defined Names” group, which helps you define and track custom cell designators, the “Formula 

Auditing” section, which helps you debug your formula, and finally, the “Calculation” section, which 

gives you control over how and when formulas are evaluated. 

 

Figure 5.20. The "Formulas" tab on the Ribbon Interface 
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Formulas can be inserted in one of two ways. The simpler, however, more advanced way is selecting 

the cell you want to insert your formula into, and then starting by typing an equal sign (“=”), followed 

by the formula. For example, typing “=A2+B2” (without the quotation marks) would insert a formula 

that would calculate the sum of the values of cells A2 and B2 and place the result in the current cell. 

Another way of inserting a formula is by selecting the cell you want to insert the formula into and then 

using the “Insert function” button from the “Formulas” tab on the Ribbon Interface. This will launch 

the “Insert Function” dialog box (Figure 5.21), which can guide you through the usage of the function 

and help you achieve your goals faster. 

 

Figure 5.21. The "Insert Function" dialog box 

Autofill and formulas 

The main advantage of formulas is that once defined for a set of values, they can be repetitively applied 

over all our data. This can be done, by first defining the formula, and then by dragging the cell either 

sideways or downwards (depending on how your data is organized) just like you would drag to use 

the Autofill function on your data (see section Autofill earlier in this chapter). 

For better explain this, let us take the data given in Figure 5.22. In column C we want to have the sums 

of columns A and B, and in column D we want to have the product of columns A and B. For this we 

define the first row of cells as presented in Figure 5.23. Finally, you drag the formulas using Autofill 

downwards, for each column. As you can see in Figure 5.24, Excel will automatically increase the row 

designator (A2, A3, A4, … and B2, B3, B4, …) when applying the formula in each row. This is because 

we dragged our formula downwards. In case we would have dragged our formula sideways, Excel 

would have increased the column designator instead (A2, B2, C2, …).  
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Figure 5.22. Raw data 

 

Figure 5.23. Define the formulas in 
the first rows 

 

Figure 5.24. Drag the formulas 
downwards in each column 

The result of the calculation can be seen in Figure 5.25. As you can observe, the results are correct for 

our defined formulas.  

 

Figure 5.25. Final results of the calculation 

There are cases, however, when we specifically want to tell Excel not to automatically increment either 

the row or column designator (or both) when calculation formulas. This can be done by placing a “$” 

symbol in front of the row or column designator. For example, “$C4” will tell Excel to lock the column 

designator to column C. So, dragging this value downwards will increase the row designator (C5, C6, 

C7, …), however, dragging it sideways will always result in C4.  

Similarly, when locking the row designator: C$4 will tell Excel not to increment the rows. So, dragging 

this value downwards will always results in C4, however, dragging it sideways will increment the 

column designator to D4, E4, F4, …, etc.  

Locking both designators, such as in $C$4, will result in C4, both when dragging horizontally and 

vertically.  

Let us take the data in Figure 5.26. We want to convert the price of some goods from EUR to RON. The 

exchange rate is stored in a static cell, found at C1. So, when doing the calculations, C1 will always be 

the cell we want to multiply the values for the EUR price of the products, found in cells B4, B4, B6, B7. 

Therefore, when we define our formula, we tell Excel that the C1 cell needs to be static, and we lock 

both the column and row designators, by using the “$” sign: $C$1. The formula used is defined in cell 

C4 and then it is dragged downwards for the other cells. Excel will automatically increment the 

designators for the price of the product but leave the conversion rate always in the static C1 cell 

(Figure 5.27.). 
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Figure 5.26. Calculation results 

 

Figure 5.27. Applied formula 

There is, however, a simpler way of doing what we just did above. Since we have already seen 

previously that you can assign custom cell designators to any cell, we can use that functionality to 

make our formula clearer and our work easier. We take cell C1 and assign a custom name, let’s say 

“conv_rate” to it, and then use that name in our formula (Figure 5.28). The result will be exactly the 

same as in Figure 5.26.  

 

Figure 5.28. Using a custom cell designator in a formula 

Tables and formulas 

Using formulas in tables is even more straightforward than using them in raw cells. When tables are 

defined, the cell designators are actually replaced by a reference to the column headers of the table, so 

the formula is more legible but also easier to follow and understand. Moreover, when defining a 

formula in a table row, this does not need to be dragged to fill the rest of the rows, this will be done 

automatically across all rows once the formula is inserted. 

Let us take the data in the table presented in Figure 5.29. We want to calculate the total price for each 

item by multiplying the item price with the purchased quantity. For this we can just start by typing “=” 

and then clicking on the cell that contains a value of the price, then typing “*” and then clicking on the 

cell than contains the quantity of the product and exiting the cell. As it can be seen in Figure 5.30, 

clicking on the cells cause Excel to automatically insert the reference to the column that was clicked 

(i.e. either [@Price] or [@Qty]). The references can also be typed out manually, however it is always 

safer to click on the cells, as this will eliminate the possibility of potential spelling mistakes and 

therefore erroneous formulas. 
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Figure 5.29. Total price calculation 

 

Figure 5.30. Formula used 

Create the table presented in Figure 5.31. The product names, prices per piece and 

quantities are inserted manually. All other cells are calculated automatically. Apply the 

following formatting options: 

• Table headers can overflow when the text does not fit within the width of the 

column. 

• Columns B, D, E and F contain EUR currency values, while column G is also 

currency, but RON. 

• Column C, representing quantity is a number with no decimal places (integer) 

Apply the following calculations: 

• Column D, the total cost in EUR excluding VAT is calculated as the price per 

piece (column B) multiplied by the purchased quantity (column C). 

• Column E, the value of VAT in EUR, is calculated as 19% of the total cost without 

VAT (column D). 

• Column F, the grand total in EUR, is calculated as the sum of the total without 

VAT and the VAT value (the sum of columns D and E). 

• Column G, the grand total in RON, is calculated as the grand total in EUR 

multiplied by the RON/EUR exchange rate (stored in cell B12). 

• Grand totals are automatically calculated by the table at the final row for 

columns D, E, F and G. 

 

 

Figure 5.31. Table to be created 
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Data validation 

Especially when using formulas, you often rely on the user to input the data type that you are actually 

expecting in a given cell. So, if you do calculations with a cell, you expect the user to input a number. 

However, if the user inputs text instead, your formula will not work. Moreover, there are times when 

you want to limit data to a minimum or maximum value, to be a whole number and not allow decimals 

and many more examples. This is where data validation comes in. 

With data validation, you can apply the following restrictions to a given cell or range of cells: 

• Any value – the default, cell accepts all inputs. 

• Whole number – a whole number (without decimals), which can be limited to a range, to a 

minimum or maximum and other constraints. 

• Decimal – a decimal number which can also be constrained as the whole number above. 

• List – a list of specified items to which the user is limited to. An in-cell dropdown menu with 

these values can be created if the appropriate checkbox is checked (see Figure 5.32). 

• Date – a date value, with optional limits. 

• Time – a time value, with optional limits. 

• Text length – text with constrained length. 

• Custom – specify a formula which validates the data. 

 

Figure 5.32. “Data Validation” dialog box 

To activate data validation, first select the cell or range of cells to which you want to apply the same 

formula. Then, in the Ribbon Interface, navigate to the “Data” tab and there from the “Data Tools” 

group select the “Data Validation” drop-down and select “Data Validation…”. This will launch the “Data 

Validation” dialog box (Figure 5.32). Here, in the “Settings” tab specify the Validation criteria. In the 

“Input Message” tab you can create a custom input message, which will be displayed to the user when 

they select the cell which contains the data validation rule, to tell them what values are expected. This 
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should be used with caution, as it can be very annoying to the user if multiple data validation rules are 

active. Finally, in the “Error Alert” tab you can specify a custom error message. This will only be 

displayed if the user enters data that is not valid, and therefore is a better way of informing the user 

of their mistake, rather than using input messages. If a custom error message is not defined, a standard 

error will be shown. 

Take the table you created in the previous exercise (Figure 5.31). Apply the following 

data validation rules: 

• The “Product name” is text, which cannot be longer than 50 characters and 

shorter than 3 characters. 

• The “Qty” (quantity) values cannot be negative or zero and will always be a 

whole number. 

• All prices must be positive decimal numbers. 

Please note that to avoid data loss, data validation is not applied retroactively. This means that if data 

validation rules are applied to cells that already have data in them, the data will not be removed, and 

the erroneous value will still be kept. 

Conditional formatting 

Conditional formatting refers to the ability to automatically format cells, rows, column and/or tables 

based on their contents. If the contents are updated, so is the formatting, automatically, without the 

need to manually make any formatting changes. This is a great way to highlight important data in your 

tables, helps you quickly identify patterns, trends, identify special or erroneous data and overall 

increase the legibility of your document. 

 

 

Figure 5.33. The "Conditional Formatting" 
option on the Ribbon Interface 

 

Figure 5.34. The “New Formatting Rule” dialog box 
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Conditional formatting works by setting rules that cause specific formatting when certain criteria are 

met. For example, you can highlight cells with values above a certain number, use color scales to show 

relative differences between values, or apply icons to categorize data into different groups. These 

visual enhancements make it easier to spot important data points. Conditional formatting is widely 

used in various business and academic settings. For instance, in project management, it can help track 

deadlines by automatically coloring cells based on how close a task is to its due date or teachers might 

use conditional formatting to visually differentiate between student grades, making it easier to see 

who is excelling or who might need extra help. 

To apply conditional formatting, first select all the cells you want the formatting rule to apply to and 

then select the “Conditional Formatting” button from the “Styles” group of the “Home” tab from the 

Ribbon Interface (Figure 5.33). Under this button you will find a set of prebuilt rules, such as 

highlighting certain cells, data bars, and color and icon scales. Some of these may be useful to you, but 

quite honestly, I have rarely seen them used in a professional document. 

A more useful feature is defining your own formatting rules by selecting “New Rule…” from the 

“Conditional Formatting” button. This will display the “New Formatting Rule” dialog box (Figure 5.34). 

Here you can select from the multitude of sets of criteria available and define which cells to format and 

how those cells should be formatted. You can even use a custom formula to define a rule.  

To be noted that if a cell fulfills multiple criteria, the earliest defined one will have priority over the 

other ones. The order in which formatting criteria are applied can be controlled from the “Manage 

Rules…” dialog box also selectable from the “Conditional Formatting” button mentioned above. 

Take the table you created in the previous exercise (Figure 5.31). Apply a conditional 

formatting rule, where if the “Grand total (RON)” column exceeds 5,000 RON, the cell is 

highlighted with a red background. The table should automatically apply or remove the 

red background when needed and should look like in Figure 5.35. 

 

 

Figure 5.35. Conditional formatting applied to the table 



Applied Informatics 

101 

Charts and graphs 

As the old saying goes: “A picture is worth a thousand words”. This is truer when representing data 

than ever. Whenever it is possible, you should present your data via a chart or a graph, rather than 

raw values in a table. This will make your data more appealing to the reader and easily understandable. 

There are several types of charts and graphs available in Excel and choosing the right one might be 

challenging sometimes. However, Excel can often help you. In order to insert a chart or graph select 

all the data you want to represent (including the table headers, as these will be used not only as legends 

or labels but will also help Excel interpret your data). Then, in the Ribbon Interface, navigate to the 

“Insert” option and from the “Charts” group, select the appropriate chart. If you are unsure what type 

of chart to use, you can select the “Recommended Charts” option. 

 

Figure 5.36 Recommended charts for a simulated election result table 

Excel offers a variety of chart types to represent data in the most meaningful way. Some of the most 

commonly used chart types include: 

• Column and Bar Charts: Ideal for comparing data across categories, these charts display data 

using vertical or horizontal bars. 

• Line Charts: Perfect for showing trends over time, line charts connect data points with a 

continuous line. 
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• Pie Charts: Useful for illustrating proportions, pie charts show how different parts contribute 

to a whole. 

• Scatter Plots: These charts are great for identifying relationships between two variables, 

plotting data points on an X and Y axis. 

• Area Charts: Similar to line charts, but with the area below the line filled in, making it useful 

for showing volume or cumulative data over time. 

There are a few recommendations you should follow when selecting and formatting your chart: 

• Keep in mind that more often than not “Less is more”: do not over-format and over-color your 

chart. Just because you can change the color, width or font size of something, does not mean 

you should. Keep your graphs and charts as clean as possible. 

• Name your axis and always provide a unit of measurement for the displayed values. Axis 

labels can be inserted by clicking on your chart and then using the big “Chart Elements” button 

on the upper right side (looks like a + sign) and selecting “Axis titles”. 

• Only use labels and legends when it is necessary and eliminate them when they are redundant 

(e.g.: a legend is not necessary of series labels also appear as callouts or under the data bars) 

• Do not use 3D charts to represent 2D data. If your data has only X and Y dimensions, do not 

use a 3D chart to represent it, although it may look “cool”. 

Although it should not be overdone, there are cases where you need to format certain elements of your 

chart. In order to do this, you can quickly double click on the element you want to format to bring up 

the “Formatting Options” sidebar (Figure 5.37). You can double click on almost any element of a chart, 

such as axis, gridlines, series and almost all visible elements.  

Users can also take advantage of features like combination charts, which allow multiple chart types to 

be displayed in a single chart, offering a more complex and informative visual representation. For 

instance, you might combine a column chart with a line chart to show both individual data points and 

overall trends simultaneously. For example, in a financial report, a combination chart could use 

columns to represent monthly sales figures while overlaying a line to show cumulative growth over 

the same period. This blend of visual elements provides a richer, more detailed analysis, making it 

easier to identify correlations, patterns, and outliers that might not be as apparent with a single chart 

type. 
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Figure 5.37. Chart "Formatting Options" sidebar 

The “Formatting Options” sidebar will automatically just to the appropriate section to format the 

selected element. Otherwise, you can manually select from a range of options available, depicted by 

the icons on the top and then by the categories below them. 

Create the pie chart presented in Figure 5.38 based on the values shown in the attached 

table. Use the appropriate formatting options to replicate the appearance of the chart as 

closely as possible.  

Without deleting the chart, use the available options to convert the above pie chart into 

the bar graph shown in Figure 5.39. 
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Figure 5.38. Pie chart to be created 

 

Figure 5.39. Convert the above pie chart to a bar graph 
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Macros 

Macros can be used to automate a repetitive task, which needs to be done over and over again. They 

offer the ability to record a set of steps and then play back the recorded steps, even at a faster pace 

than the recorded one and therefore reducing workload and worktime significantly. A macro is 

essentially a sequence of instructions or actions that you can record and save to be executed later with 

a single click. 

In order to record a macro, you must enable the “Developer” tab in the Ribbon Interface. To do this in 

Excel, navigate to the “File” tab in the Ribbon Interface, then select “Options” in the bottom left-hand 

side. The select “Customize Ribbon” and on the right side of the dialog box check the “Developer” 

option (Figure 5.40). 

 

Figure 5.40. Enabling the "Developer" tab in the Ribbon Interface 
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Then, to record a macro, access the “Developer” tab and select “Record Marco” from the “Code” group 

(Figure 5.41). This will display the “Record Macro” dialog box, where you need to give a name to your 

macro, optionally assign a shortcut key and tell Excel where to store the macro. Macros stored in “This 

workbook” will only be available locally in the workbook they were recorded in, while macros stored 

in the “Personal Macro Workbook” will be available globally. 

 

Figure 5.41. The "Developer" tab in the Ribbon Interface 

After validating the “Record Macro” dialog box, the macro will start to record and all the steps you 

execute in Excel will be recorded. You can stop the recording of the macro by using the “Stop 

Recording” button in the same “Code” group mentioned above (the “Record Macro” button will turn 

into “Stop Recording” while a macro is being recorded). 

All recorded macros are available in the “Macros” menu, from the “Code” group. Also, recorded macros 

can be added to the Ribbon Interface or the Quick Access Toolbar by customizing these. 

Record a macro that executes the following steps: 

• Completes your name in cell A1. 

• Completes your address in cell A2. 

• Formats your name as bold. 

• Formats address as red text. 

• Generates numbers from 1 to 1000 in cells A4:A1004. 

Save the macro and pin in to the Quick Access Toolbar.
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For those comfortable with coding, Visual Basic for Applications (VBA) provides the flexibility to edit 

recorded macros or write new ones from scratch. VBA allows you to add conditional logic, loops, and 

error handling to your macros, enabling them to perform complex tasks and make decisions based on 

the data they process. For example, you can create a macro that checks the value in a specific cell and 

then performs different actions depending on whether the value meets certain criteria. Additionally, 

VBA can interact with other Excel features, such as tables, charts, and external data sources, giving you 

the ability to automate nearly any task within Excel. To make your macros easily accessible, Excel 

allows you to assign them to buttons or keyboard shortcuts. You can add a button to the ribbon or 

Quick Access Toolbar, or insert a button directly into a worksheet, allowing you to run the macro with 

a single click. Alternatively, you can assign a macro to a specific keyboard shortcut, enabling quick 

execution without leaving the keyboard. 

To insert a button directly in the worksheet, you have two options. First, in the “Controls” group, select 

the “Insert” button and then under “Form Controls” select “Button” (Figure 5.42). Next, click the 

worksheet location where you want the upper-left corner of the button to appear. This will cause the 

“Assign Macro” popup window to appear and allows you to assign a macro to the button. Form controls 

are best suited for simpler tasks where you need basic interactivity without extensive customization.  

 

Figure 5.42. “Controls” group in the Developer Tab 

 

Figure 5.43. Buttons in Excel Worksheet 

Another option is using the “ActiveX Controls” instead of “Form Controls”. ActiveX Controls are ideal 

when you need advanced functionality and greater control over the appearance and behavior of your 

controls. In this case, under “ActiveX Controls” select “Command Button” and select the location where 
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you want the upper-left corner of the command button to appear. In the “Controls” group, select “View 

Code” which will automatically launch the Visual Basic Editor and activate the “Design Mode” button. 

In Figure 5.44, the sub procedure CommandButton1_Click runs the MyMacro macro when the button 

is clicked. MyMacro was recorded before and saved in the “Personal Macro Workbook”. If the macro 

had been created and saved in “This Workbook”, in the sub procedure you should only write the name 

of it. In the sub procedure of the command button, you can run multiple macros by entering the macro 

names on separate lines. As needed, feel free to add your own VBA code into the sub procedure to 

customize and enhance the functionality further. 

 

Figure 5.44. The sub procedure for the command button and MyMacro code 

To execute the VBA code linked to the button, first ensure that the Design Mode is off, then simply click 

the ActiveX command button you just created. To edit the ActiveX control, ensure you are in design 

mode.  

Form Controls and ActiveX Controls are both useful for adding buttons, checkboxes, dropdowns, and 

other user interface elements to your Excel sheets, but they differ in terms of functionality, 

customization options, and underlying technology. While Form Controls are the simpler type of the 

two, designed for straightforward tasks, ActiveX Controls offer a more advanced and flexible 

alternative, but they are specific to Excel in Windows and will not work on Mac versions of Excel.  



Applied Informatics 

109 

C h a p t er  6  

 

Microsoft PowerPoint is a presentation program, designed to facilitate oral presentation by an 

accompanying slideshow, which displays visual aids to further engage the audience. PowerPoint relies 

on slides through which the presenter moves through during their presentation. These can include 

text as well as several types of graphical elements, such as pictures, graphs/charts, tables and so on. 

Several of these can be animated in order to aid the flow of the presentation. 

To be remembered that PowerPoint is a tool just to aid your oral presentation, however, the focus 

should always be on the story you tell, the presentation you give, it is not a means to replace you as a 

presenter. It is just a utility to help you display elements that would be hard to describe in words, such 

as data charts, numerical information or to help you remember and your audience to follow along with 

your main ideas. 

In the column below, you will find several hints which you should do and not do during your 

PowerPoint presentation. Following these, will help you deliver a professional speech without being 

boring.   

In this chapter 

o DOs and DON’Ts for an oral presentation 

o Designs, themes, and layout options 

o Configuring the Slide Master 

o Using animations 

o SmartArt diagrams 
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DO… DO NOT… 

• Start by writing the content of your 

presentation first. 

• Display only main ideas on each slide. 

• Use a legible and professional looking font. 

• Use a non-obstructive and clean theme. 

• Use charts, graphs, or pictures to convey 

data (“A picture is worth a thousand 

words”). 

• Make your presentation easy to follow 

(give titles to slides, number slides, caption 

images, etc.). 

• Maintain consistency in fonts, colors, and 

slide layouts. 

• Proofread your presentation. 

• Start creating a PowerPoint presentation by 

opening the app and choosing a theme and 

colors for your slides. 

• Put everything you are about to say on the 

slide. 

• Read information off slides. 

• Use animation unless it is completely 

necessary. 

• Put irrelevant information on slides. 

• Choose dark colors (Figure 6.1). 

• Be boring. 

• Ignore slide timing. 

 

 

Figure 6.1. This slide is bad and you should feel bad 
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Designs, themes, and layout 

The first step in creating your slideshow is gathering information about the setup you will be provided 

with for your presentation. Find out if you will be using a projector or a screen to display your 

PowerPoint presentation. This is important because most projectors still use a 4:3 aspect ratio, while 

screens (or large monitors) will usually have an aspect ratio of 16:9. This is important, because having 

slides with improper aspect ratios relative to the screen will cause black banding, as seen in Figure 

6.2, to fill the unused area.  

 

Figure 6.2. Improperly set slide aspect ratios relative to presenter screen 

To set the correct slide aspect ratio, use the “Slide Size” button from the “Customize” group from the 

“Design” tab of the Ribbon Interface. Try not to change the aspect ratio after you have created your 

slideshow as this will most certainly cause elements to move around on your slides and will likely have 

unexpected consequences.  

 

Figure 6.3. Built-in slide layouts 



Applied Informatics 

112 

Next, you can choose a theme for your slides. You can do this from the “Themes” section of the “Design” 

tab. However, make sure you choose an elegant, not very crowded, and non-obtrusive theme. 

Slide layouts can be defined individually for each slide. Slide layouts control how the content is 

displayed on your slide. These practically have placeholders, where you can place your slide elements. 

There are several slide layouts you can choose from, as seen in Figure 6.3. These can be found by 

selecting the “Layout” button from the “Slides” group on the “Home” tab of the Ribbon Interface. 

The Slide Master 

The Slide Master defines the layout of the customizable elements of each theme or allows you to define 

your own. It determines where placeholders are placed, where background graphics are located, what 

colors and fonts are used. It can also add static graphic content which cannot be accidentally moved. 

The Slide Master is available from the “View” tab, by accessing the “Slide Master” button from the 

“Master Views” group (Figure 6.4). The “Slide Master” will contain a master slide, which applies to all 

slides and layouts and then a master slide for each layout available. This way you can customize all the 

slides or just the layout you want to change. 

 

Figure 6.4. Accessing the "Slide Master" 

Animations 

The first thing you need to remember is that your PowerPoint presentation is not a Pixar movie. Not 

every element should be animated. Not only can this be very distracting, but it can also ruin the pace 

of your presentation when animations do not work according to your plan or unexpected ones which 

you do not remember adding, appear. Therefore, you should only use animations when you want, for 

example, to hold off displaying something on your slide until you have finished your previous idea or 

when you want to emphasize something in the information you are presenting. Using sequential 

animations to control the flow of information, revealing one point, step, or layer at a time, allows the 

audience to absorb each piece of information before moving on to the next, improving comprehension. 

As an engineer, your presentations often deal with complex data, processes, and technical information. 

Use animations to clarify and emphasize critical points rather than to simply add visual flair. For 

example, you can use animations to sequentially highlight different parts of a diagram or process flow, 

guiding the audience through each step with precision. 
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Animations can be added by using the “Animations” tab from the “Ribbon Interface”. From here you 

can add animations to your elements and control their trigger. Animations can be triggered 

automatically together with the previous animation, after the previous one, or on click (presenter or 

mouse). You can also define the duration of your animations. Try to keep them as short as possible. 

Do not ever animate transitions between your slides. There is an option, however, I am not even going 

to tell you where it is. Just do not! 

SmartArt diagrams  

There will be occasions where you will want to create an illustration to represent a process, an 

interdependence between items or a concept which needs to be visually illustrated. For this purpose, 

you can use SmartArt diagrams built into PowerPoint (Figure 6.5). 

 

Figure 6.5. Sample SmartArt diagram 

To create a new SmartArt diagram, use the “SmartArt” button from the “Illustrations” group of the 

“Insert” tab from the Ribbon Interface. This will launch the “SmartArt chooser” dialog box, where you 

can choose the SmartArt type most useful for your needs. After that it is just a matter of adding 

elements and formatting the SmartArt diagram to your liking by using the “SmartArt Design” tab which 

will automatically appear on the Ribbon Interface when working with SmartArt diagrams. 
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Figure 6.6. SmartArt chooser dialog box 

Selecting the right SmartArt diagram type depends on the nature of the information you’re presenting 

and the message you want to convey. By considering the purpose of your content, the flow of 

information, and your audience’s needs, you can choose the SmartArt diagram that best enhances your 

presentation and makes your data more understandable and engaging. Before choosing a diagram 

type, consider the amount of text or content you need to include. Some diagrams work better with 

limited text, while others can accommodate more detailed information. 

If you need to present a series of ideas, concepts, or items that don’t follow a specific order, a List 

diagram is ideal. When illustrating a sequence of steps or a workflow, Process diagrams are the best 

choice. They help visually communicate how one step leads to the next, making them perfect for 

tutorials, procedures, or project timelines. For processes that loop or repeat, such as life cycles, 

feedback loops, or ongoing processes, Cycle diagrams are effective. They emphasize the continuity and 

repetitive nature of the information. If you need to depict levels of authority, organizational charts, or 

any kind of hierarchy, Hierarchy diagrams are ideal. They clearly show relationships between different 

levels or groups, making them useful for organizational charts, family trees, or classification 

structures. 

Avoid overcrowding your SmartArt with too much text or too many elements. Aim for simplicity to 

ensure that your diagram is easy to read and understand. Use PowerPoint’s customization options to 

adjust the colors, shapes, and layout of your SmartArt diagram to fit your presentation’s theme and 

enhance readability. 
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